EPSON

EXCEED YOUR VISION

WF-M5299 User's Guide






Contents

WF-M5299 USEr'S GUIE........cucccccmmcrerrrerrr e e s s ersers s s s re e e s e e s s s sssssssssssassss s ssssssssssnnsnnnnmmmmmmmmnnnennnnnnes 11
[ o T LT o2 0 = ] o 12
USING the CONrOl PANEI ...t e e e e as 12
Control Panel Buttons and Lights ............eeiiiiiiiiee e e e e e 13
Status 1CoN INFOrMAtION ... e e 13
Changing LCD SCreen LanQUAagE............ueiiiiiiiiiiiieiie ettt e e e e e e 14
Selecting the Date @nd TIME .......oooei oo e e e e e e e e e e e e s nnraeeeeeeeeanns 15
Adjusting the Screen Brightness. ... ..., 17
Setting a Password and Locking the Control Panel ... 17
Entering Characters onthe LCD SCreeN.........cooouviiiiiie et 19
Turning Off the Operation Time Out SEtiNgG .......vvvvviiiiii e, 19
Preventing PC Connection Via USB .........oooiiiiiiiiiii et 20
Product Parts LOCALIONS .......oooiiiiiiiiiiee ettt e e e e e e e e e e e e e e aaaaaaaaaaeens 21
Product Parts - FIONT ... et e e e e e s e e e e e e e nneeees 21
oo (U Tox =T (=T [ 1= (o = R 23
oo [N T3 = (ST = 7= T 24
The Power Off and SIEEP TIMEIS .....ccoiiiiiic e e e e e e e e e e e e e e e e e e e e e e s e e s s e s s e e ss s aannnes 24
Changing the Sleep Timer SettiNgS .........uiiiiiiiii e 25
Changing the Power Off Timer SEHNGS ........oooiiiiiie e 26
Epson Connect Solutions for Smartphones, Tablets, and More ............ccccccoo i, 27
Setting Up EPSON CONNECE SEIVICES......oiiiiiiiiiiiiiiiie e e 28
Using Epson Email Print ... e e e e e e e e e e e e e e e e e e e e e e e e e aeeas 29
Using the Epson iPrint MODIIE AP ....oiiiiiiieeeeeeeis e e e e e e e e e e e 30
Using EPSOn RemMOte PriNt ..o 30

L LT T N 11 1 U 31
UsinNg GOOgIEe ClOUA PriNt.....oooeiiiiiiiiieieee e e e e e e e e e e e e e e e e e e e e e e e e e eaeeeas 32
Setting Up Google Cloud Print on @ ChromebooK ............oooiiiiiiiiiiiiie e 33
Using the Mopria PriNt SEIVICE .......coeeiiiiiiie ettt e e e e e e e e eeaens 34
Android Printing Using the Epson Print Enabler ..........ooovveeiiiiiii e 34
USING Fire OS PriNING ...ttt e e et e e e e e e e e eeas 35



Using Windows 10 Mobile Printing .........cooooiiiii e 35

Printing with NFC from Your Android DEVICE........coooviiiiiiiiii e 36
Wi-Fi or Wired NetWOrKing........ccceeiiiiiiiieiiiiiiiiiisssrs s s e s nn s e s s 38
Network Security ReCOMMENAtiONS ..........oooiiiiiii e e e e 38
WIi-Fi Infrastructure MOdE SELUP........coooiiiii e e e e e e e e e e e e e e e e e e e e e s e e s s e aaanaanas 39
Selecting Wireless Network Settings from the Control Panel ... 40
WIi-Fi DIireCt MO SEIUP ... .o e e e e e e e e e e e e e e e e e e e e e e e s s e e s s e e e e e aanaannenanes 42
ENnabling Wi-Fi DIF€Ct MOGE .....cccooiiiieiiee et 43
Wi-Fi Protected SEtUP (WPS)....co ettt 44
Using WPS t0 Connectto a NetWOrK ... 45
Printing @ Network Status SNEet.............ooi i 46
Changing or Updating Network CONNECHIONS .........oooiiiiiiiiiiiii e 47
Accessing the Web Config ULIlity .........oooiioi e 47
Changing a USB Connection to a Wi-Fi CONNECHON..........oooiiiiiiiiiiie e 47
Changing a Wi-Fi Connection to a Wired Network Connection..............cccuveevieiiiiiiiiieee e 48
Connecting to @ NeW Wi-Fi ROULET .......oooiiiiiiiii e 48
Disabling Wi-Fi FEAUIES .......cooi i as 49
Enabling Epson Universal Print Driver (PCL) or PostScript Printing.........ccoooeiiiiiiiiiciciiiccieeeneeeneees 50
Installing the Epson Universal Print Driver - WINAOWS ............uuiiiiiiiiiiieeeeeeiieee e 50
Installing the PostScript (PS3) Printer Software - WINdOWS ...........coooiiiiiiiiiiieeee e 54
Installing the PostScript (PS3) Printer Software - Mac ...............cccccccoo e, 54
Selecting PDL (Page Description Language) Settings ..........cooiiiiiiiiiiiiiiieee e 55
PDL Print Configuration OPtiONS.........cooiiiiiiiiii et 57
Selecting Printer Language and Interface Settings ............uuuviiiiiiiiiiiiiiiie, 59
Printing Language and Interface OPtiONS .........c..uuiiiiiiiiiie e 60
Printing a PCL or PS3 (PostScript) FONt LISt ........coooiiiii e 61
LOAdiNg Paper ... 62
Installing the Optional Paper Cassette Unit..............oooiiiiiiiiiiii e 62
Enabling the Optional Paper Cassette - WiNdOWS ... 64
Enabling the Optional Paper Cassette - MacC ..........coooeiiiiiiiiii e 66
Loading Paper in the CasSEE ........coooiiiiiiiii e 67
Loading Paper or Envelopes in the Rear Paper Feed SIOt ..., 70
Paper Loading Capacily ..........coueiiiiiiiiiiiee et as 73



Double-sided Printing Capacity ...........uueiiiiiiiiiiie e 76

F V= T1E= T o] L= 0T To ] T =T 1= 77
Paper or Media Type Settings - Printing Software ... 78
Selecting the Paper Settings for Each Source - Control Panel ... 79
Paper Type Settings - Control Panel ... e e e 80
Selecting Default Paper Settings - AdminiStrator.............oooii e 81
Selecting the Default Printer Settings .....ccooov e 81
Paper Source Settings OPtiONS..........uiii i 83
Selecting the Universal Print SettNgS........ccou e 83
Universal Print Settings OPtioNS ..ot 84
Printing from @ COMPULET ... nn e 86
Printing with the Standard Epson Printer Software - Windows ... 86
Selecting Basic Print Settings - WINAOWS .........ooooiiiiiiiii e 86
Paper Source Options - WINAOWS .......ooiiiiiiei e e e e e e e e aaaaaeas 89

Print Quality OptionS - WINAOWS ........oiiiiiiiiieieee et 89
Multi-Page Printing Options - WINAOWS...........ooooiiiiii e 89
Selecting Double-sided Printing Settings - WINAOWS .........ooiiiiiiiiiiiiee e 90
Double-sided Printing Options - WINAOWS...........cooiiiiiiiiiiiie i 93

Print Density Adjustments - WINAOWS .........coooiiiiiiiii s e e e e e 93
Selecting Additional Layout and Print Options - WiNAOWS ...........ccouiiiiiiiiiiiiiieecee e 94
Image Options and Additional Settings - WiNdOWS.............cooiiiiiiiiiiic e 95
Header/Footer Settings - WINAOWS ........ooooiiiiiiiiii e 96
Selecting a Printing Preset - WINAOWS ........ooii e 97
Selecting Extended Settings - WINAOWS ........cooiiiiiiiiei e 99
Extended Settings - WINAOWS ........ooooiiiiiii e e e 100
Printing Your Document or Photo - WINAOWS..........coiiiiiiiiii e 101
Locking Printer Settings - WINAOWS .........ooiiiiiii e 102
Locked Setting OPLiONS......cooiiiiiiiii e e e e e 104
Selecting Default Print Settings - WINAOWS ..o 104
Changing the Language of the Printer Software SCreens .............ccccceiiiiiiiieiieeeeee 105
Changing Automatic Update OptioNS ........coviiiiiiiiiiii e 107
Printing with the Built-in Epson Driver - WIindows 10 S..........oiiiiiiiiie e 108
Selecting Print Settings - WINdOWS 10 S 108



Printing with the Epson Standard Printer Software - Mac ..., 112

Selecting Basic Print Settings - MAC .....ooooviiiiiiiiii e 113
Paper Source OptioNS = MAC.........ooiiiiiiiiiiiee e 116

Print Quality OptioNS = IMC .......coiiiiiiiieee et 116
Selecting Page Setup Settings - MacC .....ooeeiiiiiiiii 117
Selecting Print Layout OPptioNS = IMAC.........cuiiiiiiiiiiieee e 118
Selecting Double-sided Printing Settings - Mac............coooiiiiiee e 118
Double-sided Printing Options and Adjustments - Mac................cccccoo e, 120

(Y E=Ta = To ool @ o] (o] gl Y/ F= Lo PP PERPP 120
Color MatChiNG = IMBC ... ittt e e e e e e e eeas 120
Selecting Printing Preferences - Mac ... 121
Printing Prefer@nCes - IMAC. .......cooi e 122
Printing Your Document or PhotO - MAC .......ooooiiiii e 122
Checking Print Status - MAC.........uuiiiiiiiiiiiiie e 123
Printing with the Epson Universal Print Driver - WINAOWS...........ccooiiiiiiiiiieeee e 124
Synchronizing Printer Settings - Epson Universal Print Driver - Windows .............cccccceeiiinienee. 124
Selecting Print Settings - Epson Universal Print Driver - WindOws ............cccccoooie, 126
Selecting Default Print Settings - Epson Universal Print Driver - Windows..............cccccoooeeeeee. 128
Locking Printer Settings - Epson Universal Print Driver - Windows ............ccccooiiiiiiieiiiiniiieeeen. 129
Epson Universal Print Driver Locked Setting Options.................ooo oo 131
Adding Network Printers - Epson Universal Print Driver - Windows............ooccuiiiiiiiiiiiiieeeeeee 131
Printing with the PostScript (PS3) Printer Software - WIindOws ..o 134
Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows ....................... 134
Selecting Print Settings - PostScript Printer Software - Windows ...............c.cccooi i, 135
Selecting Default Print Settings - PostScript Printer Software - Windows.............cccccceeiiiiinneen. 139
Accessing Printer Properties - PostScript - WINAOWS ..........ccccciiiiiiiiiiiieeeeeeeeeeeeee e 140
Printing with the PostScript (PS3) Printer Software - Mac ... 141
Enabling the Optional Paper Cassettes - PostScript Printer Software - Mac ..............ccccooenn. 141
Selecting Print Settings - PostScript Printer Software - Mac .....................cc i, 142
Cancelling Printing Using @ Product BUtON ...........oooiiiiiiiii e 147
Replacing Ink Supply Units (Ink Packs) and Maintenance BOXes .........cccccccririrniinnnnnmsnsmemeemmnennenennnnn 148
Check Ink and Maintenance BOX STatUS ...t 148
Checking Ink Status on the LCD SCreeN........ccooiiiiiiiiii e 148



Checking Ink and Maintenance Box Status - WIiNdOWS.............ueiiiiiiiiiiiiiee e 149

Checking Ink and Maintenance Box Status - Mac .........cooevviviiiiiiiiiiii, 151
Purchase Epson Ink Packs and Maintenance BOXES .........ccoveeeeeieiiiii oo 153
Ink Supply Unit (Ink Pack) Part NUMDErS...........cooiiiiiii e 153
Removing and INstalling INK PaCKS...........coori i e e 154
Maintenance BOX RePIACEMENT .........oooiiiiiiii e e e e e e e aaaaaaas 157
Adjusting Print QUAIItY.......ccccccccmmiiiimiiiicir e s sssr s s s smr e s ssne e s s nn e s s sne s s n s ann e s s s snnnesesnnnnnnan 159
Print HEad MaiNtENaNCE .......coooiiiiiiiee et e e e e e e e e e e e e aaeaaeaaeeeeeeeeas 159
Print Head NOZZIE ChECK........co oottt et e e e e e e e e e e e aaaaaaaeeeeens 160
Checking the Nozzles Using the Product Control Panel ..., 160
Checking the Nozzles Using a Computer ULlity ...........cooooiiiiiii e 162

Print Head ClE@anINg ..........eeiiiiiiiii ettt e e e e e e 164
Cleaning the Print Head Using the Product Control Panel ............cccccoi, 165
Cleaning the Print Head Using a Computer ULility............cooooii e 166
Enabling the Periodic Cleaning Setting...........cocuiiiiiiiiiiic e 169

Print Quality AdJUSTMENT........ e e e e e e e s e e e e e s e e e s 169
Adjusting the Print Quality Using the Product Control Panel............cccccccoviiiiiiiiiiiiiieeeccceeeeceee e 169
Print Head AlIGNMENT ... e ettt e e e et et e e e e e e aaaaaaaaaaaaaeaaeens 171
Aligning the Print Head Using the Product Control Panel ...............cccoocoiiiiiiiiiiieeeeeeeeeeeee 172
Cleaning the Paper GUIAE ............uuiiiiiiiii ettt e e e et e e e e e e e 173
Cleaning and Transporting Your Product ..........ccoooiiiiiiiiicicccsnccccssssssssssss e s e ss s e s s s s s s s e s e e e s e e e 175
Cleaning YOoUr PrOQUCT ........cooiiiiiiiee ettt e e e e et e e e e e e ensben e e e e e e eane 175
Transporting YOUr PrOQUCT ...ttt e e e e e e 175
SOIVING Problems ... 181
Checking for SOftWare UPAAtesS.........coooi it e e e 181
Product Status MESSAQES ....coooviiiiiiiiieeeeee e e e e e e e e e 182
RUNNING @ ProdUCT CRECK ..ot 183
Resetting Control Panel Defaulls ............oooo e 185
SOIVING SELUP PrODIEMS ......eeiiiiiiiiitt et e e e e e r e eeeeeeeeees 186
Product Does Not Turn On Or Off......ooo o a e e e e e e e e e e e e e 187
Noise After INK INStallation ....... ... e e e e e e e e e e e e aaaens 187
Software Installation ProblemsS ... 187
SoIviNg NetWOrk ProbIEMS ... e e 188



Product Cannot Connect to a Wireless Router or ACCesS POINt .......oveevieiieeeieeeeeeeeeeeeeeeeeeen 188

Network Software Cannot Find Product on a Network.............cooooiiiiiiiiiiiii e 189
Product Does Not Appear in Mac Printer WindOW ... 190
Cannot Print OVEr @ NEIWOTK .........coiiiiiiiii et e e e e e e e e e e e e nnraeeeeeeeeannes 191
YoVl =0 T= ol o] o] [T 4 o1 OSSP OP PP 192
Paper Feeding ProbIEmIS ... 193
Paper Jams Inside the ProdUCL...........ooo e e e e e e 194
Paper EJeCtion ProbIemS .........ooo it e e e aaaaaa 194
Solving Problems Printing from @ COMPULET.........cooiiiiiiii e 195
NOTNING PINES ...t e e e e e e e e e e e e e e e 195
Product Icon Does Not Appear in Windows Taskbar...........ccccoooviiiiiiiiiiicicie e 196
PRINTING IS SIOW ...ttt et e e e e e e s e e e e e e e e e eeeas 197
Solving Page Layout and Content ProbIems .............uuiiiiii e 198
T NZ=T =T I [ =T = TSP 199
TOO Many Copies PriNt ...t e e e e et e e e e e e e e 199
BlanK Pages Print ...ttt 199
Incorrect Margins on PrintOUL.........ooo oo e e e e eeens 200
INncorrect Characters Print...........coo i e e e e e e e e e e e e e e e e e e e e s e e e s e e s s s e nenaes 200
Incorrect Image Size O POSITION .........oiiiiiiiii e 201

S F= T L= I T (o TV PSSR 202
Solving Print Quality ProbIEmS .........cooi e 202
White or Dark Lines in PriNtOUL ...t 203
Blurry or Smeared PrintOUL ... e e e e e e e e e e e e e e 203
Faint Printout or Printout Has Gaps ........coooiiiiii i a e e e e e e e e e 205
GraiNy PrINTOUL. ...ttt e e e e et e e e e e e e e e e e e e aaanes 205
Uninstall Your Product SOftWare.............oeiiiiiiiee et 207
Uninstalling Printing Software - Standard Epson Printer Software - Windows..............ccccccuee. 207
Uninstalling Product SOftWare - IMAC..........ccooiiiiiiiee e 208
WHEE 10 GBI HEIP ... .o e e e e e e e e e e e e e e e e e e e e e e e e e s s e e s s s e s e aannnaaeraaees 208
Technical SPeCifiCatioNs ... mn e e s s amn e e e e e e nnnan 210
Windows System REQUIFEMENTS ........coooiiiiiiiiii e e e e e e e e e e e e e e e e e e e e e e e e 210
Mac System REQUIFEMENTS .......ooiiiiiiiiiiiee et e e e e e e e e enneeees 211
Paper SPeCIfiCAtIONS ...t a e e e e aaaaaaaaaeeas 211



Printable Area SPeCifiCatioNs .........oooi i e a e e e e e e e e e e e 213

INK Pack SPECIfICAtIONS .......eeiiiiieiiiieii et e e e e e e e e e e e e eeeeeeeas 214
DIimension SPECIfiCAtIONS ......ooiiiiiiiiiii e a e e e aaaaaaaaas 215
Electrical SPeCfiCatiONS .......oooiiiiiiiee et a e e e e e e e e e e e e e 215
Environmental SPeCifiCatioNS .........ooeeuiiiiiie e 216
Interface SPECIfICAtIONS .....ooeiiiiiiiiee e e e e e e e e e e e e e e e 216
Network Interface SPecCifiCatioNS ..........cii oo 216
Safety and Approvals SPecCifiCations ............eeiiiiiiiiie e 218
o o= 219
Important Safety INSIIUCHONS ... e e e e e e e e e e e e e e 219
General Printer Safety INSIrUCHIONS ..........uuiiii e 219
Ink Pack Safety INSIrUCHIONS ... 221
Wireless Connection Safety INStrUCLONS ..., 221
LCD Screen Safety INStrUCHIONS. ..........uiiiiiiiiiie e 221
FCC ComplianCe StatemMENt.........coo it e e e e e e s e e e e e e e nnnneeeeeas 222
Binding Arbitration and Class WaVET ............coeiiiiiiiiiii e 223
LI = 1o 1= 4 F= T OSSP 226
COPYIIGNTINOLICE. ...ttt e e e et e e e e e e e e e e e e e aannees 226
A Note Concerning Responsible Use of Copyrighted Materials..............ccccccouiviiiiiiiiiiiieiieeeeeeee, 227
Default Delay Times for Power Management for Epson Products............cccccoeo oo 227
Copyright AHFIDULION ... e e e e e e 227






WF-M5299 User's Guide

Welcome to the WF-M5299 User's Guide.
For a printable PDF copy of this guide, click here.

11



Product Basics

See these sections to learn about the basic features of your product.

Note: Printing software instructions in this manual are intended for use with the standard Epson printer
software. For more information on using the Printer Command Language (PCL) or PostScript (PS3)
printer software, please see the appropriate sections.

Using the Control Panel

Product Parts Locations

The Power Off and Sleep Timers

Epson Connect Solutions for Smartphones, Tablets, and More
Using AirPrint

Using Google Cloud Print

Using the Mopria Print Service

Android Printing Using the Epson Print Enabler
Using Fire OS Printing

Using Windows 10 Mobile Printing

Printing with NFC from Your Android Device

Using the Control Panel

See these sections to learn about the control panel and select control panel settings.

Control Panel Buttons and Lights

Changing LCD Screen Language

Selecting the Date and Time

Adjusting the Screen Brightness

Setting a Password and Locking the Control Panel
Turning Off the Operation Time Out Setting
Preventing PC Connection via USB

Parent topic: Product Basics
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Control Panel Buttons and Lights
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The NFC tag

The O power button and light
The 1+ home button

The a=a Paper Setting button
The @ Stop button

The &Y reset button
The arrow buttons and the OK button
The © Back button
The Data light
0 The Error light
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Status Icon Information
Parent topic: Using the Control Panel
Status Icon Information

Your product displays status icons on the LCD screen for certain product status conditions. On the Home
screen, press the right arrow button to select Wi-Fi and press the OK button to view or change the
current network settings.

13



Icons Description

0 Displays additional information or instructions.
' Displays the Supply Status screen.
-4 Quiet Mode is enabled. Noise is reduced during printing, but the print speed may be

reduced. Press this icon to change the settings.

= Quiet Mode is disabled. Press this icon to change the settings.

1 There is a problem with the indicated setting. Select the icon to resolve the problem.

5 No Ethernet connection.

| An Ethernet connection is established.

i No Wi-Fi connection.

1] A Wi-Fi network error has occurred or the product is searching for a connection.

1 A Wi-Fi connection is established. The number of bars indicates the connection's signal
strength.

G No Wi-Fi Direct connection.

B A Wi-Fi Direct connection is established.

Parent topic: Control Panel Buttons and Lights

Changing LCD Screen Language
You can change the language used on the LCD screen.
1. Press the 9 home button, if necessary.
2. Press the right arrow button to select Settings and press the OK button.
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You see a screen like this:

Setlings
General Settings
Print Counler I

Supply Stalus

Maintenance @

Select General Settings and press the OK button.
Select Basic Settings and press the OK button.
Press the down arrow button to select Language and press the OK button.

o o bk w

Use the arrow buttons to select a language and press the OK button.
Parent topic: Using the Control Panel

Selecting the Date and Time

Select the current date, time, and daylight saving phase in your area, and choose your preferred date
and time format.

1. Press the 90 home button, if necessary.

Select Settings and press the OK button.

Select General Settings and press the OK button.
Select Basic Settings and press the OK button.
Select Date/Time Settings and press the OK button.

o &~ b
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10.
11.
12.
13.

14.
15.

You see a screen like this:

Date/Time Seltings

DateTime

Daylight Saving Time
Winter

Time Difference

Select Daylight Saving Time and press the OK button.

Select the setting that applies to your area:

* Winter: it is winter or your region does not use Daylight Saving Time (DST)

* Summer: it is spring or summer and your region uses Daylight Saving Time (DST)

Note: If your region uses Daylight Saving Time (DST), you must change this setting to match the
season. When you change from Winter to Summer, your product automatically sets its clock ahead
one hour. When you change from Summer to Winter, it sets its clock back one hour.

Select Date/Time and press the OK button.

Select the date format you want to use and press the OK button.
Use the arrow buttons and the OK button to enter the current date.
Select OK and press the OK button.

Select the time format you want to use and press the OK button.

Use the arrow buttons and the OK button to enter the current time, then select OK and press the OK
button.

Select Time Difference and press the OK button.

Use the arrow buttons and the OK button to enter the time difference between your time zone and
UTC (Coordinated Universal Time), then select Done and press the OK button.
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Parent topic: Using the Control Panel

Adjusting the Screen Brightness
You can adjust the brightness of the LCD screen.
1. Press the 90 home button, if necessary.
2. Press the right arrow button to select Settings and press the OK button.
You see a screen like this:

Setlings
General Settings
Print Counter I
Supply Stalus

Maintenancs G‘

Press the OK button to select General Settings.

Press the OK button to select Basic Settings.

Press the OK button to select LCD Brightness.

Press the left or right arrow button to decrease or increase the brightness.
Press the up arrow button to select Done.

©® N o g bk ow

Press the 91 home button to exit.
Parent topic: Using the Control Panel

Setting a Password and Locking the Control Panel

You can set an administrator password to lock the following settings and prevent them from being
changed:

+ Certain Basic Settings and Printer Settings

17



+ System Administration Settings
* Network Settings
» Web Service Settings

Note: For more information on administration settings, see the Administrator's Guide.

1. Press the 90 home button, if necessary.

2. Select Settings > General Settings > System Administration > Security Settings > Admin
Settings > Admin Password > Register.

You see a screen like this:

_@ t e N n:gn i

glw e r t ¥y u i o p

ko1 -

a 5 4 t g h |
Z X ¢ v b nm

3. Use the displayed keyboard to enter a password, then select OK and press the OK button.
4. Enter your password again to confirm, then select OK and press the OK button.
5. Select Lock Setting and select On.

When the control panel is locked, you must enter the password to access any of the locked settings.
Note: If you forget your password, contact Epson for assistance.

Entering Characters on the LCD Screen
Parent topic: Using the Control Panel
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Entering Characters on the LCD Screen
Follow these guidelines, using the control panel buttons to enter characters for passwords and other

settings.

Q| ‘>
063

glw e r t y u i o p

a s d 1 ko
M

g h |
z c v b n m

* To move the cursor, select the left or right arrows.

» To change the case of letters, select .

* To delete the previous character, select .

* To switch between letters or numbers and symbols, select E
* To change the keypad layout, select ﬁ

* To enter commonly-used domain names, select H

* To enter a space, select El
Parent topic: Setting a Password and Locking the Control Panel

Turning Off the Operation Time Out Setting

The Operation Time Out setting causes the LCD screen to return to the Home screen after a few minutes
of inactivity. This feature is enabled by default, but you can turn it off.
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Note: This setting can be locked by an administrator. If you cannot access this setting, contact your
administrator for assistance.

1. Press the 9 home button, if necessary.

2. Select Settings > General Settings > Basic Settings > Operation Time Out.
3. Press the OK button to toggle between On and Off.

Parent topic: Using the Control Panel

Preventing PC Connection via USB
You can disable access to your product from a USB-connected computer. This restricts non-network
access to the product.

Note: This setting can be locked by an administrator. If you cannot access this setting, contact your
administrator for assistance.

Press the 90t home button, if necessary.
2. Select Settings > General Settings > Printer Settings > PC Connection via USB.
You see a screen like this:

r— PC Connection wia

3. Select Disable and press the OK button.
4. Do one of the following:
» Select Yes and press the OK button to restart the product.
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+ Select No or Close and press the OK button to return to the Printer Settings screen without
restarting the product.

Note: The change will not take effect until the product is restarted.

Parent topic: Using the Control Panel

Product Parts Locations

See these sections to identify the parts on your product.

Product Parts - Front
Product Parts - Inside
Product Parts - Back

Parent topic: Product Basics

Product Parts - Front

1 Control panel

2  Papercassette 1 (C1)
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3  Paper cassette 2 (C2) (optional)

—

AN\
g

(3]

Rear paper feed edge guides
Paper support
Feeder guard

Output tray

1

2

3

4  Rear paper feed (B)
5

6 Paper cassette edge guides
7

Paper cassette

Parent topic: Product Parts Locations
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Product Parts - Inside

(1] 2]

Printer cover (J)
Print head
Ink pack tray

Front cover (A)

a b WON -

Front cover lock

Parent topic: Product Parts Locations
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Product Parts - Back

. I
000

LAN port

USB port

Service USB port (do not remove sticker)
AC inlet

Rear cover (D)

Rear cover (E)

N OO oA WN -

Maintenance box cover (H)
Parent topic: Product Parts Locations

The Power Off and Sleep Timers

The product enters sleep mode or turns off automatically if it is not used for a period of time. You can
adjust the time period before power management begins, but increasing the time reduces the product's
energy efficiency.

Changing the Sleep Timer Settings
Changing the Power Off Timer Settings

24



Parent topic: Product Basics

Changing the Sleep Timer Settings
You can adjust the time period before your product enters sleep mode and turns off the LCD screen.
1. Press the 90 home button, if necessary.

2. Press the right arrow button to select Settings and press the OK button.
You see a screen like this:

Setlings

General Settings
Print Counler I
Supply Stalus

Maintenance @

3. Press the OK button to select General Settings.
4. Press the OK button to select Basic Settings.
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5. Press the down arrow button to select Sleep Timer and press the OK button.

@ Sleep Timer

EU‘

(1 to 240 minutes)

6. Select the number field and press the OK button.

7. Select a time period between 1 and 240 minutes. Use the arrow buttons to highlight a number and
press the OK button to select it.

8. Select OK then press the OK button.
9. Select Done and press the OK button.
Parent topic: The Power Off and Sleep Timers

Changing the Power Off Timer Settings
You can have the product turn off automatically if it is not used for a specified period of time.
1. Press the 90 home button, if necessary.
2. Press the right arrow button to select Settings and press the OK button.
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You see a screen like this:

Setlings
General Settings
Print Counler I

Supply Stalus

Maintenance @

Press the OK button to select General Settings.
Press the OK button to select Basic Settings.
Press the down arrow button to select Power Off Timer and press the OK button.

Press the up and down arrow buttons to select a time period between 30minutes and 12h (12
hours), and press the OK button.

o o bk w

Parent topic: The Power Off and Sleep Timers

Epson Connect Solutions for Smartphones, Tablets, and More

Use your smartphone, tablet, or computer to print documents, photos, emails, and web pages from your
home, office, or even across the globe.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Setting Up Epson Connect Services
Using Epson Email Print

Using the Epson iPrint Mobile App
Using Epson Remote Print
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Parent topic: Product Basics

Setting Up Epson Connect Services

If you did not activate your product's email address for use with Epson Connect when you set up your
product, you can activate it using the product control panel.

1. Press the 90 home button, if necessary.

2. Press the right arrow button to select Settings and press the OK button.
You see a screen like this:

Setlings
General Settings
Print Counter I
Supply Stalus
Maintenance @

3. Press the OK button to select General Settings.

4. Press the down arrow button to select Web Service Settings and press the OK button.
5. Press the OK button to select Epson Connect Services.
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You see a screen like this:

Epson Connect

Registration
Unregistered

6. Press the OK button to select Register.

7. Press the OK button to select Start Setup.

8. Follow the instructions on the screen to activate your product's email address.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Using Epson Email Print

With Epson Email Print, you can print from any device that can send email, such as your smartphone,
tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a
PDF, Microsoft Office document, or photo to an email and send it to your product. Both the email and the
attachments will print automatically.

1. Connect your product to your network. See the link below.

2. Ifyou did not already set up Email Print when you installed your product software, see the link below
to use your product control panel to activate your unique email address. Or visit epson.com/connect
(U.S), epson.ca/connect (Canada), or epsonconnect.com (Caribbean) to learn more about Email
Print, create your Epson Connect account, and register your product to the Epson Connect service.

3. Now you are ready to send and print emails to your product's Email Print address.

Note: Go to epsonconnect.com and log into your Epson Connect account to personalize your product's
email, adjust print settings, and set up other Epson Connect services.
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Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related tasks
Setting Up Epson Connect Services

Related topics
Wi-Fi or Wired Networking

Using the Epson iPrint Mobile App

Use this free Apple and Android app to print with networked Epson products. Epson iPrint lets you print
PDFs, Microsoft Office documents, photos, and web pages from your device or from popular cloud
services such as Box, Dropbox, Evernote, Google Drive, or Microsoft OneDrive.

1. Connect your product to your wireless network. See the link below.

2. \Visit epson.com/connect (U.S), epson.ca/connect (Canada), or epson.com.jm/connect (Caribbean)
to learn more about Epson iPrint and check the compatibility of your mobile device.

3. Download Epson iPrint from the Apple App Store or Google Play.

4. Connect your mobile device to the same wireless network as your product.
5. Open Epson iPrint and select your Epson product.

Now you are ready to print with your mobile device and your Epson product.
Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using Epson Remote Print

With Epson Remote Print software, you can print from your laptop or desktop computer to an Epson
Email-enabled product anywhere in the world.

1. Connect your Epson product to your wireless network. See the link below.

2. Ifyou did not already set up an Epson Connect account when you installed your product software,
visit epsonconnect.com to create your account and register your product to the Epson Connect
service.

Note: Make a note of your product's email address.

3. Visit epsonconnect.com to learn more about Remote Print and how to download the Remote Print
Driver software.
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4. Download and install the Remote Print software.
5. Enter the email address and optional access key of your Epson product during Remote Print setup.

6. Now you are ready to print remotely. Select the print command in your laptop or desktop computer
application and choose the Remote Print option for your Epson product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using AirPrint

AirPrint enables instant wireless printing from iPhone, iPad, and iPod touch with the latest version of
iOS, and Mac with the latest version of OS X or macOS.

AirPrint

Note: If you disabled paper configuration messages on your product control panel, you cannot use
AirPrint. See the link below to enable the messages, if necessary.

Load paper in your product.
Set up your product for wireless printing. See the link below.
Connect your Apple device to the same wireless network that your product is using.

b=

Print from your device to your product.
Note: For details, see the AirPrint page on the Apple website.

Parent topic: Product Basics

Related topics
Selecting Default Paper Settings - Administrator
Wi-Fi or Wired Networking
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Using Google Cloud Print

With a Google Account, you can print from your Apple or Android device to your Epson product. You can
also print from Chromebooks and the Google Chrome browser without drivers or cables.

1.
2.
3.

Connect your Epson product to your wireless network. See the link below.
Note your product's IP address by checking your network status. See the link below.

Connect your computer or your Apple or Android device to the same wireless network as your Epson
product.

Enter your product's IP address into the address bar of a web browser.
Select the Google Cloud Print Services option.

Note: If you don't see the Google Cloud Print Services option, turn your product off and back on. If
the option still doesn't appear, select the Firmware Update option and follow the on-screen
instructions to update your product.

Click Register.

Select the checkbox to agree to the Usage Advisory and click Next.
Click OK to launch the sign-in page.

A separate browser window opens.

Enter your Google Account username and password and click Sign in, or, if you don't have an
account, click Sign up for a new Google Account and follow the on-screen instructions.

10. Click Finish printer registration to complete setup and print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook,
computer, Apple or Android device with Internet access. Visit Epson Support for Google Cloud Print
(U.S) or Epson Support for Google Cloud Print (Canada) for more information on using Google Cloud
Print, or the Google Cloud Print website for a list of supported apps.

Setting Up Google Cloud Print on a Chromebook

Parent topic: Product Basics

Related tasks
Printing a Network Status Sheet

Related topics
Wi-Fi or Wired Networking
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Setting Up Google Cloud Print on a Chromebook
With a Google Account, you can print from a Chromebook without drivers or cables.
1. Connect your Epson product to your wireless network. See the link below.
2. Turn on your Chromebook and connect it to the same wireless network as your product.

Note: See your Chromebook's documentation for details on connecting to a network.

3. Do one of the following:

» Click Add to Cloud Print in the notification that appears in the corner of your Chromebook
screen.

Note: If you do not see a notification, check to see if a number appears in the status area at the
lower-right corner of the screen. Click this number to open the notifications menu, then click Add
to Cloud Print.

* Open a web browser and enter chrome://devices in the address bar. Skip to step 5.
* If you see a registration confirmation screen instead, click Register.

4. Click Add Device.

5. Click the Register button that appears next to your product.

6. Click Register on the confirmation screen. Your product's LCD screen displays a confirmation
message.

7. Select OK or press the OK button on your product to confirm the Google Cloud Print connection and
print a test page.

Your product is now linked to your Google Account and can be accessed from any Chromebook, iPhone,
or Android phone with Internet access. Visit Epson Support for Google Cloud Print (U.S) or Epson
Support for Google Cloud Print (Canada) for more information on using Google Cloud Print, or the
Google Cloud Print website for a list of supported apps.

Parent topic: Using Google Cloud Print

Related topics
Wi-Fi or Wired Networking
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Using the Mopria Print Service

You can use the Mopria Print Service to print from your Android phone or tablet (Android v4.4 or later) to
your Epson product or any Mopria-certified product from other manufacturers. You can download the
Mopria Print Service from Google Play.

Note: For details on the Mopria Print Service, click here (U.S) or click here (Canada).

Connect your Epson product to your wireless network. See the link below.
On your Android device, download the Mopria Print Service from Google Play.

Note: On some Samsung Galaxy devices, Mopria may come preinstalled.

Go to Settings on your Android device, select Printing, and enable the Mopria Print Service.
Connect your Android device to the same wireless network as your product.

Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu
icon and select Print. Then select All printers, select your Epson product, adjust your print settings,
and print.

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Android Printing Using the Epson Print Enabler

You can wirelessly print your documents, emails, photos, and web pages right from your Android phone
or tablet (Android v4.4 or later). With a few taps, your Android device will discover your nearby Epson
product and print.

1.

o~ N

Connect your Epson product to your wireless network. See the link below.

On your Android device, download the Epson Print Enabler plug-in from Google Play.
Go to Settings on your Android device, select Printing, and enable the Epson plug-in.
Connect your Android device to the same wireless network as your product.

Now you are ready to print. From an Android application such as Chrome or Gmail, tap the menu
icon and print whatever is on the screen.

Note: If you do not see your product, tap All Printers and select your product.
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Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Using Fire OS Printing

You can wirelessly print from Amazon Fire tablets and phones to your nearby networked Epson product.
There is no software to download, no drivers to install, and no cables to connect. With just a few taps in
Email, Calendar, Contacts, and WPS Office, you can send whatever is on the screen to an Epson
product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Amazon device to the same wireless network as your product.

3. Now you are ready to print. From your Amazon application, tap the print option and select your
product to print whatever is on the screen.

Note: If you see a message telling you that a plug-in is required, tap OK and tap Download. If your
Amazon Fire product uses Fire OS 5 and above, your device automatically uses the built-in Mopria
Print Service app to print.

Visit epson.com/connect (U.S), epson.ca/connect (Canada), or epson.com.jm/connect (Caribbean) to
learn more about Fire OS Printing (one of many Epson Connect Partner Solutions) and check the
compatibility of your mobile device.

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Using Windows 10 Mobile Printing

You can wirelessly print from Windows 10 Mobile tablets and phones to your nearby networked Epson
product. There is no software to download, no drivers to install, and no cables to connect. Look for the
print option in your Windows 10 application to send whatever is on the screen to an Epson product.

1. Connect your Epson product to your wireless network. See the link below.
2. Connect your Windows 10 Mobile device to the same wireless network as your product.

3. Now you are ready to print. From your Windows 10 application, tap the print option and select your
product to print whatever is on the screen.
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Visit epson.com/connect (U.S), epson.ca/connect (Canada), or epson.com.jm/connect (Caribbean) to
learn more about Windows 10 Mobile Printing (one of many Epson Connect Partner Solutions) and
check the compatibility of your mobile device.

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Printing with NFC from Your Android Device

You can easily connect your Android 4.0 or later device to your product using NFC (Near Field
Communication). Once connected, you can print using Epson iPrint.

1. Make sure Epson iPrint is installed on your mobile device.

2. Make sure Simple AP mode is enabled on your product, that you are using the default Wi-Fi Direct
password, and that paper is loaded in the product.

Note: NFC printing will not work if you changed the default Wi-Fi Direct password.

3. Touch the NFC antenna of your mobile device to the NFC tag on your product.

Note: The location of your mobile device's NFC antenna varies. See your mobile device
documentation for more details.
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Epson iPrint opens.

Note: If you do not have Epson iPrint installed, the app store page for the Epson iPrint app opens.
Install Epson iPrint and repeat this step.

4. Touch the NFC antenna of your mobile device to the product NFC tag on your product again.
The printer and mobile device connect.

Note: If the mobile device and product disconnect, try to print a document. The mobile device and
product should reconnect automatically.

5. Open the file you want to print in Epson iPrint.
6. Touch the NFC antenna of your mobile device to the NFC tag on your product to start printing.
Parent topic: Product Basics

Related tasks
Using the Epson iPrint Mobile App
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Wi-Fi or Wired Networking

See these sections to use your product on a Wi-Fi or wired network.

Network Security Recommendations

Wi-Fi Infrastructure Mode Setup

Wi-Fi Direct Mode Setup

Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet

Changing or Updating Network Connections

Network Security Recommendations

To help deter unauthorized access to your product over a network, you should protect your network
environment using appropriate security measures.

Security measures such as these can help deter threats such as loss of user data, use of telephone and
fax lines, and other intrusions:

* Enable security on your wireless LAN

Enable the appropriate security on the wireless LAN you plan to use with your product. Network
security such as a network password can deter interception of traffic over the wireless LAN. Your
router may already have a default password enabled by your Internet service provider (ISP). See your
ISP and router documentation for instructions on how to change the default password and better
secure your network.

» Connect your product only to a network protected by a firewall

Connecting your product directly to the Internet may leave it vulnerable to security threats. Instead,
connect it to a router or other network connection protected by a firewall. Your router may already
have a firewall set up by your Internet service provider; check with your ISP for confirmation. For best
results, set up and use a private IP address for your network connection.

* Change the default administrator password on your product

If your product has an option to set an administrator password, change the default administrator
password to deter access by unauthorized users to personal data stored on your product, such as IDs,
passwords, and contact lists.

Parent topic: Wi-Fi or Wired Networking
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Wi-Fi Infrastructure Mode Setup

You can set up your product to communicate with your computer using a wireless router or access point.
The wireless router or access point can be connected to your computer over a wireless or wired network.

Epson product

Wireless router or access point
Computer with a wireless interface
Computer

Internet

oo o0~ WDN -

Ethernet cable (used only for wired connection to the wireless router or access point)

Selecting Wireless Network Settings from the Control Panel
Parent topic: Wi-Fi or Wired Networking
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Selecting Wireless Network Settings from the Control Panel
You can select or change wireless network settings using your product control panel.

To install your product on a wireless network, follow the instructions on the Start Here sheet and install
the necessary software by downloading it from the Epson website. The installer program guides you
through network setup.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not
responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your network data and settings.

1. Press the 90 home button, if necessary.
2. Select Wi-Fi.
You see a screen like this:

Metwork Connection Seltings

3. Select Router.

4. Select Start Setup, Change Settings, or Change to Wi-Fi connection, depending on your current
connection settings.

5. Select Wi-Fi Setup Wizard.

6. Select the name of your wireless network or select Enter Manually to enter the name manually. Use
the displayed keypad to enter your network name.
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7. Select the Enter Password field and enter your wireless password using the displayed keypad.

@I s ¢
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a s d 1 B
X

t
g h |
z ¢ v b nm
Note: The network name and password are case sensitive. Be sure to correctly enter uppercase and
lowercase letters, and numeric or special characters.

» To move the cursor, select the left or right arrows.
» To change the case of letters, select .

* To delete the previous character, select .

» To enter numbers and symbols, select H

* To change the keypad layout, select ﬁ

* To enter a space, select El
8. Select OK when you finish entering your password.
9. Confirm the displayed network settings and select Start Setup to save them.

10. If you want to print a network settings report, select Print Check Report. (Otherwise, select
Dismiss.)

11. Press the 90 home button to exit.
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You see the " icon on the LCD screen and should be able to connect to your product directly from
your computer or device, and then print. If you are printing from a computer, make sure you installed
the network software as described on the Start Here sheet.

Note: If you don't see the ¥ icon, you may have selected the wrong network name or entered the
password incorrectly. Repeat these steps to try again.

Parent topic: Wi-Fi Infrastructure Mode Setup

Related references
Status Icon Information

Related tasks
Entering Characters on the LCD Screen

Wi-Fi Direct Mode Setup

You can set up your product to communicate directly with your computer or another device without

requiring a wireless router or access point. In Wi-Fi Direct Mode, the product itself acts as a network
access point for up to 4 devices.

7 («

1 Epson product
2 Computer with a wireless interface
3  Other wireless device

Enabling Wi-Fi Direct Mode

42



Parent topic: Wi-Fi or Wired Networking
Enabling Wi-Fi Direct Mode

You can enable Wi-Fi Direct mode to allow direct communication between your product and computer or
other devices without a wireless router or access point.

1. Press the 90 home button, if necessary.
2. Select Wi-Fi.
You see a screen like this:

Metwork Connection Settings

3. Select Wi-Fi Direct > Start Setup.
4. Select Start Setup again.
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You see a screen like this:

 ciose |

On the smart device's Wi-Fi setup
screen, select the following SSID. |

network (S3I0)

DIRECT-FEDCBASS a

Password

19 ERTE

5. Use your computer or wireless device to select the Wi-Fi network name (SSID) displayed on the
LCD screen, then enter the password shown.

6. Press the 90t home button to exit.

You see the & icon on the LCD screen and should be able to connect to your product directly from
your computer or device, and then print. If you are printing from a computer, make sure you installed
the network software as described on the Start Here sheet.

Note: If you don't see the & icon on the LCD screen, you may have selected the wrong network
name or entered the password incorrectly. Repeat these steps to try again.

Parent topic: Wi-Fi Direct Mode Setup

Related references
Status Icon Information

Related tasks
Entering Characters on the LCD Screen

Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your
product to the network using Wi-Fi Protected Setup (WPS).
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Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access
point. If there is no hardware button, there may be a virtual WPS button in the software for the device.
Check your network product documentation for details.

Using WPS to Connect to a Network

Parent topic: Wi-Fi or Wired Networking

Using WPS to Connect to a Network

If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to
connect your product to the network.

1. Press the 90 home button, if necessary.
2. Select Wi-Fi.
You see a screen like this:

Metwork Connection Settings

3. Select Router.

Select Start Setup, Change Settings, or Change to Wi-Fi connection, depending on your current
connection settings.

5. Select Push Button Setup (WPS).
Follow the instructions on the LCD screen to complete WPS setup.
Press the 91 home button to exit.
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You see the " icon on the LCD screen and should be able to connect to your product directly from
your computer or device, and then print. If you are printing from a computer, make sure you installed
the network software as described on the Start Here sheet.

Note: If you don't see the ¥ icon, repeat these steps to try again.

Parent topic: Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet

You can print a network status sheet to help you determine the causes of any problems you may have
using your product on a network.

1. Press the 0" home button, if necessary.
2. Select Settings.
You see a screen like this:

Setlings
General Settings
Print Counler I

Supply Status

Maintenance G‘

3. Select General Settings > Network Settings > Network Status > Print Status Sheet > Print.
4. Press the OK button.

Examine the settings shown on the network status sheet to diagnose any problems you have.
Parent topic: Wi-Fi or Wired Networking
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Changing or Updating Network Connections
See these sections to change or update how your product connects to a network.

Accessing the Web Config Utility

Changing a USB Connection to a Wi-Fi Connection
Changing a Wi-Fi Connection to a Wired Network Connection
Connecting to a New Wi-Fi Router

Disabling Wi-Fi Features

Parent topic: Wi-Fi or Wired Networking

Accessing the Web Config Utility

You can select your product's network settings and confirm its operating status using a web browser.
You do this by accessing your product's built-in Web Config utility from a computer or other device that is
connected to the same network as your product.

Note: For more information on administration settings, see the Administrator's Guide.

Print a network status sheet.
Locate the IP address for your product that is listed on the network status sheet.

3. On a computer or other device connected to the same network as your product, open a web
browser.

4. Enter your product's IP address into the address bar.
You see the available Web Config utility options.
Parent topic: Changing or Updating Network Connections

Changing a USB Connection to a Wi-Fi Connection

If you have already connected your product to your computer using a USB connection, you can change
to a Wi-Fi connection.

1. Disconnect the USB cable from your product.
2. Uninstall your product software.

3. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections
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Changing a Wi-Fi Connection to a Wired Network Connection

If you have already connected your product to your computer wirelessly, you can change to a wired
network connection if necessary.

1.

© ®©® N o ok wbd

Disable your product's Wi-Fi features.

Connect one end of an Ethernet network cable to the product's LAN port.

Connect the other end to any available LAN port on your router or access point.
Uninstall your product software.

Download and install your product software from the Epson website.

Follow the on-screen instructions to install the software.

When you see the Select Your Connection screen, select Wired network connection.
If you see a Select Setup Option screen, select Set up printer for the first time.
Continue following the rest of the on-screen instructions.

Parent topic: Changing or Updating Network Connections

Related tasks
Disabling Wi-Fi Features

Connecting to a New Wi-Fi Router

If you change the wireless router you have been using on your network, you need to update your
product's Wi-Fi connection to the new router.

Note: If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

1.

Do one of the following:
* Windows: Uninstall your product software.
* Mac: Go to the next step.

Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections

Related concepts
Uninstall Your Product Software
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Disabling Wi-Fi Features

You may need to disable your product's Wi-Fi features if you change your network connection type or
need to solve a problem with your network connection.

Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and
password, and any network settings selected for the Epson Connect services you may use.

1. Press the 90 home button, if necessary.
2. Select Wi-Fi.

You see a screen like this:

Metwork Connection Settings

3. Select Router > Change Settings > Others > Disable Wi-Fi.
4. Select Start Setup to disable Wi-Fi.

Parent topic: Changing or Updating Network Connections
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Enabling Epson Universal Print Driver (PCL) or PostScript
Printing
Before enabling Epson Universal Print Driver (PCL) or PostScript printing on your product, make sure
you have installed the software as described on the Start Here sheet.

To download the Epson Universal Print Driver or PostScript drivers, visit epson.com/support (U.S.),
epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

Installing the Epson Universal Print Driver - Windows
Installing the PostScript (PS3) Printer Software - Windows
Installing the PostScript (PS3) Printer Software - Mac
Selecting PDL (Page Description Language) Settings
Selecting Printer Language and Interface Settings
Printing a PCL or PS3 (PostScript) Font List

Installing the Epson Universal Print Driver - Windows
The Epson Universal Print Driver supports multiple printer languages, such as PCL and ESC/P-R, and
can be installed on a Windows computer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software. Depending on your model, not all printer languages may be supported.

1. To download the EPSON Universal Print Driver file, visit epson.com/support (U.S.),
epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select your product.

2. Double-click the downloaded package.
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3. Follow the on-screen instructions until you see this screen:

EPSOM Printer Uitilities Setup

Detect the printer, and automatically configure the port.
Is $he printer connecied via a network 7

(®)Yea: Histwork connectiar]

Saarch aplions ..

et () No: USE connection

[[] Set Defaut of Frinter Corbrol Language to PCLE

OK Abort

4. Select Yes: Network connection and click OK.

Note: Select the Set Default of Printer Control Language to PCL6 checkbox if you want to set the
default printer language to PCL6. Leave this option deselected to set the printer language to ESC/P-
R. (You can change this setting later as needed.)
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After the software finishes searching for products, you see a screen like this:

! EPS0OM Printer LHilities Setup 7 ®
(%) Add EPSON Liniwansal Print Driver
() Add fiound perters
Seladd & pad ta carmect & prrier
Salact from found panters o
Found Printers:
Mode! flame P Addness MAL Addness Location
WP XG0 192 16813000 DO2GABFREDIC
V- 20000 152 1681000 ACTRIEICE0RC Unberienan
W= 2000 182 1681000 DOZEABFFISED Linkncwm
< >
£ Set as defaull prnter Diaplay Setngs
= ]

5. Do one of the following:

* If you are installing one product, make sure Add EPSON Universal Print Driver is selected and
continue with the next step.

+ If you are installing more than one product, select Add found printers and go to step 9.

Note: You can customize and filter your product search results by clicking Display Settings.
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Open the Select a port to connect a printer menu and select an existing printer port, if necessary.
Otherwise, skip this option to create a new port automatically.

Select the product you want to install from the Found Printers list.

Note: Deselect the Set as default printer checkbox if you do not want the product to be set as your
default printer.

Click OK, then skip the remaining steps.

If you are installing more than one product, select the products from the Found Printers list and click
Add to Printer Folder.

! EPSOM Printer Lialities Setup 7 by

() Add EPSOMN Urievaraal Print Driver
(%) Add fourd perters

Salect prirters from the falowing list, amd then dick the "Add to Prinber Falder” bufton . (You can
select mubple printers from the: list )

Found Printers:
Madel Mame P Address MAL Address Locaton il
WF- X000 192 16813000 ACB2E2BET
WF-2000 152 16813000 B4EBBC2551CE
WE- 00 192 1681000 EAEBBCTANFID
WIP-X0H 192 16813000 DO2GABFREDIC
WF-20000 152 168110004 AC1EMEICH05C
ET- X0 192168 130001 40244048341
REAE A0 88 4 M ABECSERM v
L4 *
Ak tio Printer Folder | Diaplay Settings
Printers to be addsd
Mam= of added prinler IF Address

[ ERSOM Universal Print Dierver WF- 30004 192,168, 1. 3000
[C] EPSOM Universal Print Detver WF-1000 152.168.1.3060C

indio Edit

Salerd & prnter from ihe s 1o 28 § & the delasuk prinber

Help Aot 0K Back
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The selected products appear in the lower section of the screen.
10. Select the checkbox next to the product you want to make your default printer, if necessary.
11. Click OK.
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Installing the PostScript (PS3) Printer Software - Windows

If you did not install the standard Epson printer software or Epson Universal Print Driver, you need to
install the PostScript (PS3) printer software before you can adjust the print settings and print to your
network printer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software.

1. To download the Drivers and Utilities Combo Package - PS3 PostScript file, visit
epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and
select your product.

Double-click the downloaded package.

Click OK.

Click Accept.

Click Install.

Click Next and follow the on-screen instructions.

I

Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Installing the PostScript (PS3) Printer Software - Mac

If you did not install the standard Epson printer software, you need to install the PostScript (PS3) printer
software before you can adjust the print settings and print to your network printer.

Note: Make sure your product is turned on and connected to the same network as your computer before
installing the printer software.

1. Todownload the Drivers and Utilities Combo Package - PS3 PostScript file, visit
epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and
select your product.

2. Double-click the downloaded package.
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If necessary, enter the administrator password.

3. Double-click EPSON.

4. Click Continue on the next two screens.
5. Click Agree.

6. Click Install.

7.

8

. Click Start and follow the on-screen instructions.
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Selecting PDL (Page Description Language) Settings

You can select settings for PCL and PostScript printing using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

Press the 90 home button, if necessary.
Select Settings.

3. Select General Settings.
You see a screen like this:

General Settings
Basic Settings
Printer Setlings

Metwork Setlings

Web Service Settings @

4. Select Printer Settings.
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You see a screen like this:

Printer Settings

Paper Source Settings

Printing Language r

Universal Print Settings

PDL Print Configuration a

5. Select PDL Print Configuration.
You see a screen like this:

PDL Print Configuration

Common Settings

PCL Menu

PS3 Menu

6. Select one of the options shown above, then select the PDL print configuration options you want to
use.

7. When you are finished, press the 4+ home button to exit.
PDL Print Configuration Options
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing
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PDL Print Configuration Options

Select the PDL Print Configuration options you want to use for PCL or PostScript printing.

PDL Print Configuration
option

Available
settings

Description

Common Settings

Paper Size Various sizes Sets the default paper size for PCL or PostScript
printing

Paper Type Various paper Sets the default paper type for PCL or PostScript
types printing

Orientation Portrait Sets the default orientation for PCL or PostScript
Landscape printing

Quality Draft Sets the quality for PCL or PostScript printing
Standard
Best

Ink Save Mode On/Off Saves ink by reducing print density

Print Order

Last Page on
Top

Starts printing from the first page of a file

First Page on
Top

Starts printing from the last page of a file

Number of Copies 1to 999 Selects the number of copies to print

Binding Margin Left Edge Specifies the binding edge for double-sided documents
Top Edge

Auto Paper Ejection On/Off Ejects paper automatically when printing is stopped

during a print job

2-Sided Printing On/Off Selects double-sided printing

PCL Menu

Font Source Resident Uses a font preinstalled on the printer
Download Uses a font you have downloaded
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PDL Print Configuration | Available Description
option settings
Font Number 1to 111 Selects the default font number for the default font

source

Pitch 0.44 t0 99.99 cpi | Selects the default font pitch if the font is scalable and
fixed-pitch (availability depends on font source and
number settings)

Height 4.00 t0 999.75 pt | Selects the default font height if the font is scalable and
proportional (availability depends on font source and
number settings)

Symbol Set Various Selects the default symbol set. If the selected font is not
available for the selected symbol set, the font source
and number are replaced with IBM-US (the default
setting).

Form 510 128 lines Sets the number of lines for the selected paper size and
orientation. Changes the line spacing (VMI) stored in
the printer. Later changes in page size or orientation
cause changes in the Form value based on the stored
VMI.

CR Function CR Selects the carriage return and line feed commands

CR+LF when printing with a driver from a specific operating
system

LF Function LF

CR+LF

Paper Source Assign 4 Makes the paper source select command compatible

with HP LaserJet 4

4K Makes the paper source select command compatible
with HP LaserJet 4000, 5000, and 8000

58 Makes the paper source select command compatible
with HP LaserJet 5S

PS3 Menu

Error Sheet On/Off Prints a sheet showing the status when errors occur

during PostScript or PDF printing
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PDL Print Configuration
option

Available
settings

Description

Binary

On/Off

Enable when printing files that contain binary images
(available when the product is connected to the
network). Allows you to print binary images even if the
driver is set to ASCII.

PDF Page Size

Various sizes

Selects the paper size when printing a PDF file. If Auto
is selected, the paper size is determined based on the
size of the first page.

Parent topic: Selecting PDL (Page Description Language) Settings

Selecting Printer Language and Interface Settings

You can select printer language and interface settings using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

Press the 90t home button, if necessary.

Select Settings.

3. Select General Settings.

You see a screen like this:

Basic Settings
Printer Setlings

Metwork Setlings

Web Service Settings

General Settings
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4. Select Printer Settings.
You see a screen like this:

Prinler Settings
Paper Source Settings
Printing Language I

Universal Print Settings

PDOL Print Configuration Q

5. To change interface settings, scroll down and select the interface options for your connection type.

6. To select printer language settings, select Printing Language, then select the printing language
options for your connection type.

7. When you are finished, press the 42> home button to return to the Home screen.
Printing Language and Interface Options
Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

Printing Language and Interface Options
Select the printing language and interface options you want to use.

Option Available Description
settings
PC Connection via USB | Enable Select whether to allow USB communication with the
Disable product
USB I/F Timeout Setting [ 0.5 to 300 Specify the length of time before ending USB
seconds communication from a computer using the PCL or
PostScript driver. This setting is necessary to avoid
endless USB communication.
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Option Available Description
settings

Printing Language Auto Select the language for the USB or network interface
PCL
PS3
PDF

Parent topic: Selecting Printer Language and Interface Settings

Printing a PCL or PS3 (PostScript) Font List

You can print a PCL or PS3 (PostScript) font list to confirm the current font information.
1. Press the 90 home button, if necessary.
2. Select Settings.

You see a screen like this:

Setlings
General Settings
Print Counler I

Supply Stalus

Maintenance G

Scroll down and select Printer Status/Print.

Select Print Status Sheet.

Select PS3 Font List or PCL Font List .

Select Print to print the font list.

Parent topic: Enabling Epson Universal Print Driver (PCL) or PostScript Printing

o o bk w
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Loading Paper

Before you print, load paper for the type of printing you will do.

Installing the Optional Paper Cassette Unit

Loading Paper in the Cassette

Loading Paper or Envelopes in the Rear Paper Feed Slot
Paper Loading Capacity

Double-sided Printing Capacity

Available Epson Papers

Paper or Media Type Settings - Printing Software

Selecting the Paper Settings for Each Source - Control Panel
Selecting Default Paper Settings - Administrator

Installing the Optional Paper Cassette Unit
You can install an optional paper cassette unit to provide more paper capacity.
1. Turn off the product, and unplug the power cord and any connected cables.

Warning: To avoid electric shock, make sure you unplug the power cord.

2. Remove the paper cassette unit from its packaging and remove any protective materials.
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3. Lift up your product and gently lower it onto the paper cassette unit with the corners aligned.

Warning: To lift the product, have two people hold it as shown here. Lifting from other areas may
cause the product to fall or cause you to pinch your fingers when placing the product down.
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4. Place the cassette number sticker on the cassette unit.

5. Connect the power cord and other connection cables, then plug in the product.
6. Turn on the product.

7. Pull out and reinsert the paper cassette in the optional paper cassette unit, and confirm that the
cassette unit number appears on the screen.

8. Enable the optional paper cassette unit in the product software.

Enabling the Optional Paper Cassette - Windows
Enabling the Optional Paper Cassette - Mac

Parent topic: Loading Paper

Enabling the Optional Paper Cassette - Windows

You need to enable the optional paper cassette unit before you can use it with the printer software.

Note: If you are using the Epson Universal Print Driver or PostScript (PS3) printer software, see the link
below to enable the optional cassette unit.

1. Do one of the following:

* Windows 10: Click E and select k=4 (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printer properties.
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+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Printer properties.

* Windows 7: Click E and select Devices and Printers. Right-click your printer name and select
Printer properties.

* Windows Vista: Click E and select Control Panel. Click Printer under Hardware and Sound,
then right-click your printer name and select Properties.
2. Click the Optional Settings tab.

You see a window like this:

& EPSOM Unncersal Print Drives Properties =

Genersl Shasng Forlr  Achvanced  Color Mermgemsnl  Sscurty  Oolional Sefings  Visrmion Infomeston

}\ Pranber Lithty

e
:5.5! Metwork printer seanch
%

‘:h- Dvivier S4ttings

CuFTent Frinter Infonmason

Printsr Tnfermaton

Prindar Typd A

Trikcjeet Prinber (W) Acguire from Printer Get
o] Hame

WF-HHKE Senes [ ondy Cptional Tnformartion
Priver Moded

AdiLetter Codor (5tandand Resolubon &00

Default of Printer Control Language (_}Manusl Setings
ESCFHR
Ak Dupheer Instaed
Trestabi
Confidentia Job s
<8 »
0K Cancal [Hasip

3. Make sure Acquire from Printer is selected, then click Get.

The optional paper sources are listed in the Current Printer Information section.
4. Click OK.
The optional paper cassette is now enabled.
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Parent topic: Installing the Optional Paper Cassette Unit

Related tasks

Synchronizing Printer Settings - Epson Universal Print Driver - Windows
Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows

Enabling the Optional Paper Cassette - Mac

You need to enable the optional paper cassette unit before you can use it with the printer software.

Note: If you are using the PostScript (PS3) printer software, see the link below to enable the optional

cassette unit.

In the Apple menu or the Dock, select System Preferences.

2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options

& Supplies.
3. Select Driver or Options.
You see a screen like this:

doumenitaten.
Thick papss snd emalopei:
Skip Blank Page:
et Mode:
Permit temporany black printing:
High Spoed Printing:
Outpist cocuenonts for (iling:
Warning Notifiepise:
Eatanlish Bidinsctional comemunication:

Lowor Castatbe:

General Options  Supply Levels  Uitility

To take full advantage of your primer's options, confirm that they are accurately shown
g, For information o your prined sod itg opticnad harndwane, chagk the peirter's

0]
O
o

O

L2 1]
Oy
O

A% [ dn (4x (€3] €3 (43 (43 |4 |4b

Cassatte 2

Cancel [+].4
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4. Select the optional cassette unit you installed as the Lower Cassette setting.
5. Click OK.

The optional paper cassette is now enabled.

Parent topic: Installing the Optional Paper Cassette Unit
Related tasks
Enabling the Optional Paper Cassettes - PostScript Printer Software - Mac

Loading Paper in the Cassette

You can load paper up to this size in the paper cassette: Legal (8.5 x 14 inches [216 x 356 mm])
Note: If the optional paper cassette unit is installed, do not remove more than one cassette at a time.

1. Make sure the product is not operating and pull out the paper cassette.
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2. Slide the front edge guide outward all the way, then slide the side edge guides to the paper size you
are using.

4 )

3. Load paper with the printable side facedown and slide the front edge guide against the paper.

Note: Make sure the paper fits beneath the arrow mark inside the edge guides.

68



4. Insert the paper cassette all the way into the product.

5. Do one of the following:
» Select the size and type of paper you loaded on the LCD screen.

+ Press the m=a Paper Setting button and select the paper source, then select the size and type of
paper you loaded.

» Select the size and type of paper you loaded in the Settings > General Settings > Printer
Settings > Paper Source Settings > Paper Setup menu.

Always follow these paper loading guidelines:

* Load only the recommended number of sheets.

* Load paper short edge first, no matter which way your document faces.

* Load the printable side facedown.

* Load letterhead or pre-printed paper top edge first.

* Do not load paper above the line underneath the arrow mark inside the edge guides.
» Check the paper package for any additional loading instructions.
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Parent topic: Loading Paper

Related references
Paper Loading Capacity
Paper Specifications

Related tasks
Loading Paper or Envelopes in the Rear Paper Feed Slot

Loading Paper or Envelopes in the Rear Paper Feed Slot
You can print envelopes or documents in a variety of paper types and sizes in the rear paper feed slot.
1. Open the feeder guard and pull up the paper support.

4 p |
%\ RV/ |
=

2. Slide the edge guides outward.

\L T T JJ’

- -

[ ]
d’ m--g-\

70



3. Ifyou are inserting a stack of paper, fan the sheets and tap the stack on a flat surface to even the
edges.

Note: You can load one sheet of binder paper with holes on one of the long edges as shown. Do not
select automatic 2-sided printing for this type of paper. Select Letterhead or Preprinted as the

paper type setting.

I I 000000000000

000000000000
000000000000

4. Do one of the following:
* Insert paper, glossy or printable side up and short edge first, in the center of the slot.

1

Caution: To prevent paper feeding problems, make sure you do not load paper above the arrow
marks inside the edge guides.
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» Load envelopes short edge first, with the flap facing down and the flap edge to the left, in the
center of the slot.

Eé
I

5. Slide the edge guides against the paper, but not too tightly.

= =

N

6. Extend the output tray.
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7. Do one of the following:
» Select the size and type of paper you loaded on the LCD screen.

+ Press the ma Paper Setting button and select the paper source, then select the size and type of
paper you loaded.

+ Select the size and type of paper you loaded in the Settings > General Settings > Printer
Settings > Paper Source Settings > Paper Setting menu.

Always follow these paper loading guidelines:

* Load only the recommended number of sheets.

* Load paper short edge first, no matter which way your document faces.

» Load the printable side faceup.

» Load letterhead or pre-printed paper top edge first.

* Do not load paper above the line under the arrow mark inside the edge guides.

 If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one
envelope at a time.

« If print quality declines when printing multiple envelopes, try loading one envelope at a time.
» Do not load envelopes that are curled, folded, or too thin.

» Do not load windowed envelopes or envelopes with adhesive surfaces on the flaps.

» Check the paper package for any additional loading instructions.

Parent topic: Loading Paper

Related references

Paper Specifications

Paper Loading Capacity
Related tasks

Loading Paper in the Cassette

Paper Loading Capacity

As described in the tables below, do not load paper in the paper cassettes above the arrow marks on
these stickers inside the cassette:

v

» Use this guide for standard paper:
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v

|
» Use this guide for thick paper: s

Standard and Thick Paper Capacity

You can load up to the following number of sheets in the rear paper feed slot:

» 80 sheets of standard paper; load only 1 sheet of paper in a user-defined size between 14 inches
(355.6 mm) and 236 inches (6000 mm) long

« 30 sheets of thick paper (25 to 68 Ib [91 to 256 g/m?]); load only 1 sheet of thick paper in a user-
defined size between 14 inches (355.6 mm) and 44 inches (1117.6 mm) long (available only when
printing from a computer)

* 10 envelopes

Letterhead paper
Recycled paper
Colored paper
Pre-printed paper
High-quality plain paper

User defined (4 x 5.8
inches [100 x 148 mm]
to0 8.5 x 14 inches [216 x
355.6 mm])

Paper type Paper size Loading capacity
Cassette 1 Cassette 2 (optional)
Plain paper Available paper sizes* [ Up to the arrow mark on the cassette sticker

User defined (2.5 % 5
inches [64 x 127 mm] to
8.5 x 14 inches [216 x
355.6 mm])

User defined (2.5 x 14
inches [64 x 355.6 mm]
to 8.5 x 236 inches [216
x 6000 mm])

User defined (3.5 % 5
inches [89 x 127 mm] to
8.5 x 5.8 inches [216 x
148 mm])

User defined (3.5 x 5.8
inches [89 x 148 mm] to
4 x 14 inches [100 x
355.6 mm])

Up to the arrow mark on
the cassette sticker
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inches [89 x 127 mm] to
8.5 x 5.8 inches [216 x
148 mm])

User defined (3.5 x 5.8
inches [89 x 148 mm] to
4 x 14 inches [100 x
355.6 mm])

Paper type Paper size Loading capacity
Cassette 1 Cassette 2 (optional)
Envelopes #10 10 —
Thick paper (25 to 43 Ib | Available paper sizes* |90 250
2

[91 to 160 g/m7]) User defined (4 x 5.8

inches [100 x 148 mm]

to 8.5 x 14 inches [216

x 355.6 mm])

User defined (3.5 % 5 90 —

User defined (2.5 x 5
inches [64 x 127 mm] to
8.5 x 14 inches [216 x
355.6 mm])

User defined (2.5 x 14
inches [64 x 355.6 mm]
to 8.5 x 44 inches [216 x
1117.6 mm])

* Select the paper specification link below to view the list of available paper sizes.

Note: Half Letter size is not available when printing with the PostScript printer driver.

Epson Paper Capacity

Paper type

Loading capacity

Cassette 1

Cassette 2 (optional)

Rear paper feed slot

Epson Bright White
Paper

200 sheets

400 sheets

50 sheets
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Paper type Loading capacity

Cassette 1 Cassette 2 (optional) Rear paper feed slot

Epson Presentation 80 sheets — 70 sheets
Paper Matte

Epson Premium 50 sheets — 20 sheets
Presentation Paper
Matte

Epson Premium
Presentation Paper
Matte Double-sided

Note: When printing at a user defined size on genuine Epson paper, you can only print at Standard or
Normal print quality. Even if the printer driver allows you to choose a better print quality, the printer will
print using Standard or Normal print quality.

Parent topic: Loading Paper

Related references
Paper Specifications

Double-sided Printing Capacity
Automatic Double-sided Printing

You can automatically print double-sided from any paper source on the following sizes of standard and
thick papers (up to 43 Ib [160 g/m?)):

o Letter (8.5 % 11 inches [216 x 279 mm])

* A4 (8.3 x 11.7 inches [210 x 297 mm])

» Executive (7.25 x 10.5 inches [184 x 267 mm])

Manual Double-sided Printing

You can manually print double-sided pages using only the rear paper feed with the following papers:

76



Paper type Size Manual double-sided
printing capacity

Plain paper Available paper sizes' 30 sheets
Copier paper User defined (8.5 x 14 to 236 inches |1 sheet

2
Letterhead paper [216 % 355.6 to 6000 mm])
Recycled paper
Colored paper
Pre-printed paper
High quality plain paper
Epson Bright White Paper Letter (8.5 x 11 inches 30 sheets

[216 x 279 mm])
Thick paper 1 (25to 43 1b [91 to 160 | Available paper sizes' 5 sheets
2

g/mI) User defined (8.5 x 14 to 44 inches | 1 sheet
Thick paper 2 (43 to 68 Ib [161 to [216 x 355.6 to 1117.6 mm])?
256 g/m?))

': Select the paper specification link below to view the list of available paper sizes.
2. Available only when printing from a computer
Parent topic: Loading Paper

Related references
Paper Specifications

Related tasks
Selecting Double-sided Printing Settings - Windows
Selecting Double-sided Printing Settings - Mac

Available Epson Papers

You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com (U.S. sales),
epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from
an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S.
or 800-807-7766 in Canada.

Note: Paper/media availability varies by country.
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Paper Type Size Part number Sheet count
Epson Bright White Paper Letter (8.5 x 11 inches S041586 500
[216 x 279 mm])
Epson Presentation Paper Matte | Legal (8.5 x 14 inches S041067 100
[216 x 356 mm])
Letter (8.5 x 11 inches S041062 100
[216 x 279 mm])
Epson Premium Presentation 8 x 10 inches (203 x 254 mm) | S041467 50
Paper Matte Letter (8.5 x 11 inches S041257 50
[216 > 279 mml]) 5042180 100
Epson Premium Presentation Letter (8.5 x 11 inches S041568 50
Paper Matte Double-sided [216 x 279 mm])

Parent topic: Loading Paper

Paper or Media Type Settings - Printing Software

For this paper

Select this Paper Type or Media Type setting

Plain paper
Epson Bright White Paper

Plain Paper

High-quality plain paper

High Quality Plain Paper

Letterhead paper Letterhead
Recycled paper Recycled
Colored paper Color
Pre-printed paper Preprinted
Envelopes Envelope

Epson Presentation Paper Matte
Epson Premium Presentation Paper Matte

Epson Premium Presentation Paper Matte Double-
sided

Premium Presentation Paper Matte
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For this paper Select this Paper Type or Media Type setting

Thick paper (25 to 43 Ib [91 to 160 g/m?]) Card Stock 1

Thick paper (43 to 68 Ib [161 to 256 g/m?]) Card Stock 2

Note: The settings listed here are available only when printing from your computer; they do not apply to
your product's control panel settings.

Parent topic: Loading Paper

Selecting the Paper Settings for Each Source - Control Panel

You can change the default paper size and paper type for each source using the control panel on the
product.

1. Press the ma Paper Setting button.
You see a screen like this:

Paper Setfing

C1
Ad

Flain Paper

B

A ©

2. Select the identifier for the paper source you want to select settings for. Make sure the identifier
matches the label for that paper source on the product.
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You see a screen like this:

C1

Select the size and type of the leaded
paper.
Paper Size
A
Paper Type
Plain Paper

Select Paper Size.
Select the paper size you loaded.
Select Paper Type.

N o ok ow

Paper Type Settings - Control Panel
Parent topic: Loading Paper

Paper Type Settings - Control Panel

Select the paper type for the paper you loaded.

Press the O Back button to select another paper source or press the 41 home button to exit.

Select a Paper Type setting that matches the paper you loaded.

Paper type loaded Paper Type setting
Plain paper Plain Paper

Epson Bright White Paper

Letterhead paper Letterhead
Recycled paper Recycled

Colored paper Color
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Paper type loaded Paper Type setting

Pre-printed paper Preprinted

High-quality plain paper High Quality Plain Paper
Envelopes Envelope

Epson Presentation Paper Matte Prem. Matte

Epson Premium Presentation Paper Matte

Epson Premium Presentation Paper Matte Double-
sided

Thick paper up to 25 to 43 Ib (91 to 160 g/m?) Card Stock 1

Thick paper up to 43 to 68 Ib (161 to 256 g/m?) Card Stock 2

Parent topic: Selecting the Paper Settings for Each Source - Control Panel

Selecting Default Paper Settings - Administrator

As an administrator, you can adjust default paper settings that apply to all print jobs sent to the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

Selecting the Default Printer Settings
Selecting the Universal Print Settings

Parent topic: Loading Paper

Selecting the Default Printer Settings

You can change default printer settings using the control panel on the product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the 9 home button, if necessary.
2. Select Settings.
3. Select General Settings.
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You see a screen like this:

General Settings

Basic Settings

Printer Setlings

Network Sellings

Web Service Settings @

4. Select Printer Settings.
You see a screen like this:

Printer Settings

Paper Source Settings

Printing Language r

Universal Print Settings

PDL Print Configuration a

5. Select one of these options for the Auto Error Solver setting:

» Turn on this setting to display a warning and print single-sided when a 2-sided printing error
occurs, or to print only what the printer could process when a full memory error occurs.

» Turn off this setting to display an error message and stop printing if an error occurs.
6. Select Paper Source Settings.
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7. Select the Paper Source Settings options you want to use.

8. When you are finished, press the 4 home button to exit.

Paper Source Settings Options

Parent topic: Selecting Default Paper Settings - Administrator
Paper Source Settings Options

Select the paper source options you want to use for your print jobs.

Paper Source Available settings [Description
Settings option
Paper Setting Various Select the paper size and type for each paper source
Rear Paper Feed |On Select On to give printing priority to paper loaded in the rear
Priority paper feed slot

Off
Ad4/Letter Auto On Select On to switch the selected paper size to match the
Switching Off loaded paper (Letter or A4) if the wrong size is selected
Auto Select C1 Select On for any of these settings to automatically print on
Settings c2 paper from that source if it contains paper that matches your

paper settings

B

Error Notice Paper Size Notice | Select On for either of these settings to display an error
. message when the selected paper type or size does not

Paper Type Notice match the loaded paper
Paper Setup On Select On to automatically display a menu that lets you
Auto Display Off select the paper size and type when you load paper in the

product

Note: If you disable this setting, you will not be able to print
using AirPrint.

Parent topic: Selecting the Default Printer Settings

Selecting the Universal Print Settings
You can change the default universal print settings using the control panel on the product.
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Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the 9 home button, if necessary.
2. Select Settings > General Settings > Printer Settings > Universal Print Settings.
You see a screen like this:

Liniversal Print Seftings
Top Offset
JOmm
| Leit Offset
Q. 0rm
Top Offzet in Back
0.0mm
Left Offset in Back
1 e

3. Adjust the settings as necessary.
4. When you are finished, press the 41 home button to exit.
Universal Print Settings Options
Parent topic: Selecting Default Paper Settings - Administrator
Universal Print Settings Options
Select the universal print setting options you want to use for your print jobs.

Universal Print | Available settings |Description

Settings option

Top Offset — Adjust the top or left margin
Left Offset
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Universal Print
Settings option

Available settings

Description

Top Offset in
Back

Left Offset in
Back

Adjust the top or left margin of the back page when printing
double-sided

Check Paper On Select On to check the paper width before printing. This
Width Off prevents printing beyond the edges of the paper when the
paper size settings are incorrect, but may reduce the print
speed.
Skip Blank Page [On Select On to skip printing of blank pages automatically
Off

Parent topic: Selecting the Universal Print Settings
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Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its software
as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions.

Printing with the Standard Epson Printer Software - Windows
Printing with the Built-in Epson Driver - Windows 10 S
Printing with the Epson Standard Printer Software - Mac
Printing with the Epson Universal Print Driver - Windows
Printing with the PostScript (PS3) Printer Software - Windows
Printing with the PostScript (PS3) Printer Software - Mac
Cancelling Printing Using a Product Button

Printing with the Standard Epson Printer Software - Windows

You can print with the standard Epson printer software using any Windows printing program, as
described in these sections.

Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
Selecting Additional Layout and Print Options - Windows
Selecting a Printing Preset - Windows

Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows

Locking Printer Settings - Windows

Selecting Default Print Settings - Windows

Changing Automatic Update Options

Parent topic: Printing from a Computer

Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.
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1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.
Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

- S‘llrﬂln; Peederemoes ®

Man  More Options  Mantenance

Printing Frescls Poper Sourge | Auto Select b
Add Remave Presets. . Dieerirren® Sog Lether (2.5 x 11in) b
&) Bocument - Fadt
= Dogumnent - Sundind Qualty Crribatien CPerirat (W) Lancespe
S Decument « Moh Qualty
o Decument - 2-5ded Paper Type Figin Pagetr | Bright Whate Page w
5] Deament - 2400
T Decument « J<Suded with 240 Quabty Stondand w
TEdedPFrnang |OfF b

— Wads Page off - et O
i Copes |8 : £ Colate
—_— e EARetras Order
§ Ot Miode o W

Ehew Setongs [ peiet Peeves
(et aveanger Lise

Reset Defmits Ik Lo

[Cox ] cmes || b

4. Forthe Paper Source setting, select where you loaded the paper you want to print on.
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10.

11.
12.
13.

14.

Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.
Select the orientation of your document.

Note: If you are printing an envelope, select Landscape.

Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

Select the Quality setting that matches the print quality you want to use.

To print on both sides of the paper, select the 2-Sided Printing setting and select the options you
want.

To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select
one of the settings in the Multi-Page menu and select the printing options you want.

To print multiple copies and arrange their print order, select the Copies options.
To preview your job before printing, select Print Preview.

To save your print job as a project that can be modified and combined with other print jobs, select
Job Arranger Lite.

To reduce noise during printing when you select Plain Paper/Bright White Paper, select On in the
Quiet Mode menu.

Note: Enabling Quiet Mode may reduce printing speed.

Paper Source Options - Windows
Print Quality Options - Windows
Multi-Page Printing Options - Windows

Parent topic: Printing with the Standard Epson Printer Software - Windows

Related references
Paper or Media Type Settings - Printing Software
Double-sided Printing Capacity
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Related tasks
Printing Your Document or Photo - Windows

Paper Source Options - Windows

You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.

Note: Paper Cassette 2 is available only if you have installed the optional cassette.

Auto Select
Automatically selects the paper source based on the selected paper size.

Paper Cassette 1
Selects the paper in cassette 1 as the paper source.

Paper Cassette 2
Selects the paper in cassette 2 as the paper source.

Rear Paper Feed
Selects the paper in the rear feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - Windows
Print Quality Options - Windows

You can select any of the available Quality options to fine-tune the quality of your print. Some settings
may be unavailable, depending on the paper type and border setting you have chosen.
Draft
For draft printing on plain paper.
Standard
For everyday text and image printing.
Fast
Speeds up printing on plain paper.
High
For photos and graphics with high print quality.
Parent topic: Selecting Basic Print Settings - Windows
Multi-Page Printing Options - Windows

You can select any of the available options in the Multi-Page menu to set up your multi-page print job.
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2-Up and 4-Up
Prints 2 or 4 pages on one sheet of paper. Click the Page Order button to select page layout and
border options.

2x1 Poster, 2x2 Poster, 3x3 Poster, 4x4 Poster

Prints one image on multiple sheets of paper to create a larger poster. Click the Settings button to
select image layout and guideline options.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Double-sided Printing Settings - Windows
You can print on both sides of the paper by selecting one of the 2-Sided Printing options on the Main
tab.

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network.

2-Sided Printing | Off (¥

1. Select one of the following options for 2-Sided Printing:

* Auto (Long-edge binding) to print your double-sided print job by automatically flipping the paper
on the long edge.

+ Auto (Short-edge binding) to print your double-sided print job by automatically flipping the paper
on the short edge.

* Manual (Long-edge binding) to print your double-sided print job by printing one side and
prompting you to flip the paper over on the long edge to print the other side (recommended for
paper types that do not support automatic duplexing).

* Manual (Short-edge binding) to print your double-sided print job by printing one side and
prompting you to flip the paper over on the short edge to print the other side (recommended for
paper types that do not support automatic duplexing).

2. Click the Settings button.
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You see this window:

Binding Settings

Binding Edge
s rop ot
O Long-edge O Short-edge O Long-edge
i | —
Binding Margin

Front Page 0.00 % [0.00... 1.18]
Back Page 0.00 = [0.00...1.18]

Unit Omm (®)inch

Start Page
(®) From Front

() From Back

Create Folded Booklet
[]Booklet

Center Binding Side Binding
/Jﬁﬁ
cancel

3. Select the double-sided printing options you want to use.
4. Click OK to return to the Main tab.
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7.
8.
9.

Click the Print Density button.
You see this window:

Print Density Adjustment

Select Decumeant Type

() Text (@) Text & Graphicst () Text & Photos () User-Defined
Adjustments
Print Density L (%)
-5 1]
Increase Ink Drying Time " il (sec)
] &0

(o] o | o

Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

If necessary, select the Adjustments options you want to use.
Click OK to return to the Main tab.
Print a test copy of your double-sided document to test the selected settings.

10. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options - Windows

Print Density Adjustments - Windows

Parent topic: Printing with the Standard Epson Printer Software - Windows
Related references

Double-sided Printing Capacity

Related tasks
Selecting Basic Print Settings - Windows
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Double-sided Printing Options - Windows

You can select any of the available options on the Binding Settings window to set up your double-sided
print job.

Binding Edge Options
Select a setting that orients double-sided print binding in the desired direction.

Binding Margin Options
Select options that define a wider margin to allow for binding.

Start Page
Selects whether printing starts on the front or back page.

Create Folded Booklet Options
Select the Booklet checkbox and a binding option to print double-sided pages as a booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows
Print Density Adjustments - Windows

You can select any of the available options on the Print Density Adjustment window to adjust the print
quality of your double-sided print job.

Print Density
Sets the level of ink coverage for double-sided printing.

Increase Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing to prevent ink smearing.

Parent topic: Selecting Double-sided Printing Settings - Windows
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Selecting Additional Layout and Print Options - Windows

You can select a variety of additional layout and printing options for your document or photo on the More

Options tab.
% Prrting Prefenerced ®
Man  More Optons  Mantenance
Prinking Prescls Denmnent Sioe Lether (3.5 x 11 in) i
Add Fremive Presets... hpionst Papr Same &5 Document Size bt
=] Document - Fast ) Reduce Enlarge Deoument
] Denuement « Standard Quality W .
S Deoument - Hgh Quaity
o Doament - 2-Saded
AL2] Degenuvebril - 2405 Tone Comecton
T Desement « 2oSabed with 24p -
) dustommatie O uion
Emage Options. ..
Watermark Features...
| [ Confidental Job
Addtany Settrn
[rotaze 150+
A igh Speed
[mteres bmagee
s | [t

1. To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select one of these sizing options:

» Select the Fit to Page option to size your image to fit the paper you loaded. Select the size of your
document or photo as the Document Size setting, and the size of your paper as the Output
Paper setting. If you want to center your image on the paper, select the Center option.

+ Select the Zoom to option to reduce or enlarge your document or photo by a specific percentage.
Select the percentage in the % menu.

2. Select one of the following Tone Correction options:
+ Select Automatic to automatically adjust the brightness and contrast for your image.
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+ Select Custom and click the Advanced button to manually adjust the tone correction settings or
turn off color management in your printer software.

+ Select Image Options to access additional settings for improving printed images.
3. To add the following features, click the Watermark Features button:
+ Watermark: adds a visible watermark to your printout
» Header/Footer: adds information such as the date and time to the top or bottom of your printout

Note: Click the Settings button to customize the text and location of the header or footer.

4. To add a password to your print job, select the Confidential Job checkbox, then enter a password.
Confidential jobs are stored in the product's memory without being printed. To print the job, enter the
password for the confidential job on the product's control panel.

Note: Confidential print jobs are cleared from the product's memory after printing.

5. Select any of the Additional Settings options to customize your print.

Image Options and Additional Settings - Windows
Header/Footer Settings - Windows

Parent topic: Printing with the Standard Epson Printer Software - Windows

Related tasks
Printing Your Document or Photo - Windows

Image Options and Additional Settings - Windows
You can select any of the Image Options and Additional Settings to customize your print. Some options
may be pre-selected or unavailable, depending on other settings you have chosen.
Image Options

Emphasize Text
Adjusts the weight of printed text to increase readability.

Emphasize Thin Lines
Adjusts the weight of printed lines to increase visibility.

Edge Smoothing
Smooths jagged edges in low-resolution images such as screen captures or images from the Web.
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Additional Settings Options

Rotate 180°
Prints the image rotated 180° from its original orientation.

High Speed
Speeds up printing but may reduce print quality.

Mirror Image
Flips the printed image left to right.

Parent topic: Selecting Additional Layout and Print Options - Windows
Header/Footer Settings - Windows

You can select any of the Header/Footer Settings options to add headers or footers when you print. The
items are available to print at the top or bottom of your pages, in either the left, right, or center of the

page.

Note: These settings are not saved with your document.

Header/Footer Settings

Top Left Top Center Top Right

Liser Name | MNome v Date,Time =
Bottom Left Bottom Cenber Bevttom Right

More w | Nome w Mone w

Resst Defaults IE Cancel Help

You can select to print the following information:
* User Name

» Computer Name

+ Date

+ Date/Time

* Document Name

* Collate Number (copy number)
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Note: The user name, computer name, date, and time come from the Windows Control Panel on your
computer.

Parent topic: Selecting Additional Layout and Print Options - Windows

Selecting a Printing Preset - Windows

For quick access to common groups of print settings, you can select a printing preset on the Main or
More Options tab.

Note: You can create your own preset by clicking the Add/Remove Presets button.

1. Click the Main or More Options tab.
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You see the available Printing Presets on the left:

E.-E_;I Printing Preferences
Main  More Options  Maintenance

Printing Presets

Add/Remove Presets...

E] Document - Fast

E] Document - Standard Quality
E Document - High Quality

=to Document - 2-Sided
Document - 2-p

cro Document - 2-Sided with 2-Up

Show Settings

Reset Defaults E Ink Levels i

2. Place your cursor over one of the Printing Presets to view its list of settings.

3. Click on a preset to change its settings, or use any of the available options on the screen to control
your printing presets.

98



4. To choose a preset for printing, select it.
5. Click OK.
Parent topic: Printing with the Standard Epson Printer Software - Windows

Selecting Extended Settings - Windows

You can select additional settings that apply to all the print jobs you send to your product.

1. Access the Windows Desktop and right-click the !1-:‘ icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

Select Printer Settings.
3. Click the Maintenance tab.
You see the maintenance options:

s EPLON b
Man  More Cptions  Mortensnce
@ Mezdie Chedk E PSR Status Moriter 3
W | Hesd Cepring E Mg T ete e
ﬂlhﬂ Extended Settngs
8 o
@ Job Aerarger Lite '% Pririter aned Qipticn [nfarmation
Larage Eruginin (Fragin) - ¥ Saftware Lpdate
e Oriree Suppset
0K Cancsl Help

4. Click the Extended Settings button.
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You see this window:

Estpnded Lemingn
Ot i
Wrarsd T ] [ . .
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00 b 1] i Pagesr i o g
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5. Select any of the extended settings to customize your print.

6. Click OK to close the Extended Settings window.

7. Click OK to close the printer software window.

Extended Settings - Windows

Parent topic: Printing with the Standard Epson Printer Software - Windows
Extended Settings - Windows

You can select from these settings on the Extended Settings window.

Enable EPSON Status Monitor 3
Enables product monitoring for ink and paper supplies and other issues.

Check Paper Width Before Printing

Prevents printing beyond the edges of the paper if the paper size setting is incorrect; may reduce print
speed.

Thick Paper and Envelopes
Prevents ink from smearing when you print on envelopes or other thick paper.
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Separator Page
Before each document, prints a separator page containing the title, user, date, and time.

Always Spool RAW Datatype
Increases print speed and may solve other printing problems.

Page Rendering Mode
Increases print speed when printing is extremely slow or the print head stops during printing.

Print as Bitmap
Increases print speed when printing is extremely slow or the print head stops during printing, and
other settings do not help.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Change Standard Resolution
Reduces the resolution of print data to correct printing problems.

Refine screening pattern
Prints graphics with a finer screening pattern.

Allow Applications to Perform ICM Color Matching
Allows applications to perform ICM color matching.

Always Use the Driver's Paper Source Setting
Prints using the paper source setting in the printer driver, rather than the setting in your application.

Output 1 page documents facedown in 2-Sided mode
Outputs single-sided pages in a 2-sided print job facedown instead of faceup.

Output documents for filing
Outputs all landscape, portrait, 1-sided, and 2-sided documents in the same orientation for easier
filing.

Barcode mode

Reduces bleeding when printing barcodes on plain paper, letterhead paper, recycled paper,
preprinted paper, envelopes, and thick paper.

Parent topic: Selecting Extended Settings - Windows

Printing Your Document or Photo - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.
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You see your application's Print window, such as this one:

= Prant o
Generd

Select Printer

FE EPSON {7 Microsoft XPS Documen
= Fax

= Microseft Print ta PDF

£ >
Status Ready [JFirtofie | Preferences
Locateon:
Commeant Fing Pringer...
Page Range
CIE| Mumber of copies: |1 &

1_ 1 2 2 3 1 3

Carel

2. Click OK or Print to start printing.
Parent topic: Printing with the Standard Epson Printer Software - Windows

Locking Printer Settings - Windows
Windows administrators can lock access to some printer settings to prevent unauthorized changes.

1. Do one of the following:

* Windows 10: Click E and select k=4 (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printer properties.

+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product and select Printer properties.

* Windows 7: Click E’ and select Devices and Printers. Right-click your product and select
Printer properties.
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+ Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click your product and select Properties.

2. Click the Optional Settings tab.

Note: You can prevent access to the Optional Settings tab by changing the user or group
permissions in the Security tab.

3. Click Driver Settings.
You see this window:

Dirwer Settings

Bederares frator Levk Funcion Bbverced Settngs
[ ansi-Copy Fatten

[ Watermark

] e ticr Fontier

[ 2-mded printing
[ e rage

[l Bccument Sestings:

S - R

4. Select the checkbox for each setting you want to lock. To lock all print settings, select All Document
Settings.

5. Under Advanced Settings, select the setting option you want to use for each locked setting.
6. Click OK.

Locked Setting Options

Parent topic: Printing with the Standard Epson Printer Software - Windows
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Locked Setting Options

Select the options you want to use for any locked print settings.

Setting Options Description
Anti-Copy Various data items Lets you select the data to use for the pattern or prohibit anti-
Pattern copy patterns
Add/Delete Lets you add or delete a customized anti-copy pattern
Settings Lets you select the arrangement, size, and other settings for
the custom anti-copy pattern
Watermark Various text Lets you select the text for the watermark or prohibit

watermarks watermarks

Add/Delete Lets you add or delete a customized text or image-based
watermark

Settings Lets you select the size, position, and other watermark

settings

Header/Footer Off Prohibits headers or footers

On Allows headers and footers

Settings Lets you select the text and position for printing headers and

footers

2-sided printing | Off Allows printing on one side of the paper only

On Allows printing on both sides of the paper
Multi-Page Off Prohibits multi-page settings

2-Up Allows printing of 2 pages on one sheet of paper

4-Up Allows printing of 4 pages on one sheet of paper

Parent topic: Locking Printer Settings - Windows

Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.
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1. Access the Windows Desktop and right-click the 3"-’ icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click ."h.-’

2. Select Printer Settings.
You see the printer settings window:

% Prnvting Preferences ®

Man  More Options  Manterance

Printing Prescls Paper Source Pt Select bl
Add Riamave Presets.,. Docunent Sioe  Lether (2.5 x 11in) -
&) Decument - Fast
=] Document - Stancaed Qualty Craeritanon (CPertrmst (®) Lavisene
| Document - Hgh Quaity
7 Document - 2-Saded Paper Type Pl Pager | Bragint White Pager e
Ale] Decurmepnit - 2400
T Documtnt - Dided with 4D Qualty Standard =
SdedPrntng  |OFF o
=] @ — = V .
-_! — : - EAcolate
— ] e FAreverse Drder
1 Cuuiet Mode o »
Sz Settrgs [Jpeet Previem
Doy Areanger Lite
Riedet Dafpits Ik L .
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3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Changing the Language of the Printer Software Screens

Parent topic: Printing with the Standard Epson Printer Software - Windows
Changing the Language of the Printer Software Screens

You can change the language used on the Windows printer software screens.
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1. Access the Windows Desktop and right-click the h} icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click 2%,

2. Select Printer Settings.

You see the printer settings window.
3. Click the Maintenance tab.

You see the maintenance options:

o EPSON »
Marn  Mos Optisns  Martenance
@ Farse Chad E EFSOM Status Moriter 3
Wk | Hesd Cooring E Mirnseng B eferenoes
#{_{ﬂ Extended Sekimgs
8 oo
@ Jos Aerpres Lite i% Pririter aned Oiption [nformaton
Lorge Eraginin (Ergini) o ¥ Software Lpdate
versn Onirie Suppt
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4. Select the language you want to use as the Language setting.

5. Click OK to close the printer software window.

The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows
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Changing Automatic Update Options

Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the !1-; icon for your product in the right side of the
Windows taskbar, or click the up arrow and right-click .

2. Select Software Update Settings.
You see this window:

Software Update Settings X

Check for Software Updates on the Internet

(®) Check every 2 wesks w

L:,I Mewer

cancel

3. Do one of the following:

» To change how often the software checks for updates, select a setting in the Check every menu.
» To disable the automatic update feature, select the Never option.
4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with the Standard Epson Printer Software - Windows
Related tasks
Checking for Software Updates
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Printing with the Built-in Epson Driver - Windows 10 S
You can print with the built-in Epson printer driver using any printing program on Windows 10 S, as
described in these sections.

Note: The built-in Epson driver in Windows 10 S does not include all the available print settings for your
product. To print with additional settings, download and install the Epson Print and Scan utility from the
Windows Store. You cannot download and install any Epson product software from the Epson website
for use with Windows 10 S; you must obtain software only from the Windows Store.

Selecting Print Settings - Windows 10 S
Parent topic: Printing from a Computer

Selecting Print Settings - Windows 10 S
Select the settings for your print job in your Windows 10 S application.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.
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You see a window like this:

% Epson ESC/P-R VA Class Driver Printing Preferences A
Layoud  Papes/Cusity
Tray Sedection
Advanced...
Concel | [ ooty

Select the type of paper you loaded as the Media setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

Click the Advanced button.
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You see a window like this:

Epson ESC/P-R V4 Class Driver Advanced Options H

me Epson ESC/P-R V4 Class Driver Advanced Document Settings
=11 Paper/Qutput

Paper Size: Lether

Copy Count: || = Collated

Select the size of the paper you loaded as the Paper Size setting.

To print multiple copies, select or enter the number as the Copy Count setting.

To print multiple copies of multi-page documents in sets, select the Collated checkbox.
Click OK.

You return to the printing preferences window.
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10. Select the Layout tab.

i Epson ESC/P-R VA Class Diiver Printing Preferences b

Layout  Pages/Chulty

Crientation:

(B oot

Prant on Both Sedes:
4 Mone V]

[0

Advanced_..

I =T

11. Select the orientation of your document as the Orientation setting.
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12. To print double-sided, select one of the Print on Both Sides options, depending on how you want to
orient the page layout. The icon next to each option shows the layout.

" Epson ESC/P-R VY Class Dirvwer I.'-'nn-.mg Preferences oo
Lyt Paper Dty
Crientation
[#] Portrait

Prant on Both Sedes:
A Mone w

EF Flip on Long Edge
§ Fip on Short Edge —_—

Advanced_..

[ ok ][ conce

13. Click OK to save your settings.
You see your application's Print window.
14. Click OK or Print to start printing.
Parent topic: Printing with the Built-in Epson Driver - Windows 10 S

Printing with the Epson Standard Printer Software - Mac

You can print with your product using any Mac printing program, as described in these sections.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website.

Selecting Basic Print Settings - Mac
Selecting Page Setup Settings - Mac
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Selecting Print Layout Options - Mac

Selecting Double-sided Printing Settings - Mac
Managing Color - Mac

Selecting Printing Preferences - Mac

Printing Your Document or Photo - Mac

Parent topic: Printing from a Computer

Related references
Paper or Media Type Settings - Printing Software

Related tasks
Selecting Page Setup Settings - Mac

Selecting Basic Print Settings - Mac
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

Printer: EPSON

(B

Presets: Default Settings

L]

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Printer: EPSON o
Presets: Default Settings H
Copies: (1
Pages: © all
Selected Page in Sidebar
From: 1 to: |1
Paper Size: US Letter E B.50 by 11.00 inches

Orientation: If s

Preview E

Auto Rotate Show Notes
Scale:
D Scale to Fit: D Print Entire Image

Fill Entire Faper

Copies per page: 1 E

Cancel m

Note: The print window may look different, depending on the Mac OS version and the application
you are using.

Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
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Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

Select Print Settings from the pop-up menu.

v Preview

Layout

Color Matching
Paper Handling
Cover Page

Print Settings
Two-sided Printing Settings

Supply Levels

You see these settings:

Print Settings -

L4

Paper Source:  Auto Select

Media Type: Plain Paper [ Bright Whita Paper

L %]

Print Quality: Marmal

[ 4]

* Advanced Settings:

Cancel Print
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9. Select the Paper Source you wish to print from.
10. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

11. Select the Print Quality setting you want to use.

12. Select any of the available print options.

Paper Source Options - Mac

Print Quality Options - Mac

Parent topic: Printing with the Epson Standard Printer Software - Mac
Paper Source Options - Mac

You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.

Note: Cassette 2 is available only if you have installed the optional cassette.

Auto Select
Automatically selects the paper source based on the selected paper size.

Cassette 1
Selects the paper in cassette 1 as the paper source.

Cassette 2
Selects the paper in cassette 2 as the paper source.

Rear Paper Feed
Selects the paper in the rear feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - Mac
Print Quality Options - Mac

You can select any of the available Print Quality options to fine-tune the quality of your print. Some
settings may be unavailable, depending on the paper type setting you have chosen.
Draft

For draft printing on plain paper.

Normal
For everyday text and image printing.
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Quality
For text and graphics with increased quality and print speed.

Fast
Speeds up printing on plain paper.

Parent topic: Selecting Basic Print Settings - Mac

Selecting Page Setup Settings - Mac

Depending on your application, you may be able to select the paper size and orientation settings from
the print window.

Paper Size: US Letter %+ B.50 by 11.00 inches

Orientation: || g Te

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting.
2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, select the icon.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing with the Epson Standard Printer Software - Mac
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Selecting Print Layout Options - Mac

You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.

Layout K

Pages per Sheet: 1 ﬂ
Layout Direction: g_ ‘: HH A

Border: Mone d

o-Sided:

Reverse page orientation
Flip horizontally

Cancel | S

» To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

» To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
» Toinvert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing with the Epson Standard Printer Software - Mac

Selecting Double-sided Printing Settings - Mac

You can print on both sides of the paper by selecting Two-sided Printing Settings from the pop-up
menu on the print window.

Two-sided Printing Settings &

Two-sided Printing: Off

[ 4]
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Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network. This screen may be different, depending on the Mac
OS version you are using.

Select one of the Two-sided Printing options.

2. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

Two-sided Printing Settings &

L

Two-sided Printing:  Long-Edge binding

Document Type: Text

€3

¥ Adjustments:
Print Dansity
] (%]
-50 0
Increased Ink Drying Time:
i} (sec)
4] +50

When printing a photo or document containing a lot of solid image
areas, reduce the density of the ink and increase its drying time.

Cancel Print

3. If necessary, customize the Adjustments settings as instructed on the screen.
4. Print a test copy of your double-sided document to test the selected settings.
5. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options and Adjustments - Mac

Parent topic: Printing with the Epson Standard Printer Software - Mac
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Related references
Double-sided Printing Capacity

Double-sided Printing Options and Adjustments - Mac

You can select any of the available options in the Two-sided Printing Settings pop-up menu to set up
your double-sided print job.

Long-Edge binding
Orients double-sided printed pages to be bound on the long edge of the paper.

Short-Edge binding
Orients double-sided printed pages to be bound on the short edge of the paper.

Print Density
Sets the level of ink coverage for double-sided printing.

Increased Ink Drying Time

Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing.

Parent topic: Selecting Double-sided Printing Settings - Mac

Managing Color - Mac

You can adjust the Color Matching settings to fine-tune the colors in your printout, or turn off color
management in your printer software.

1. Select Color Matching from the pop-up menu in the print window.

Color Matching [~ |

ColorSyne D EPSON Color Contrals

2. Ifyou selected ColorSync, select Other Profiles from the Profile drop-down menu to choose an
available ColorSync profile.

Color Matching - Mac
Parent topic: Printing with the Epson Standard Printer Software - Mac
Color Matching - Mac

You can select from these settings on the Color Matching menu.
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Color Matching Settings

EPSON Color Controls
Lets you manage color using controls in your printer software or turn off color management.

ColorSync
Prints using standard color profiles for your product and paper to help match image colors. You can
customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.

Parent topic: Managing Color - Mac

Selecting Printing Preferences - Mac
You can select printing preferences that apply to all the print jobs you send to your product.
1. Inthe Apple menu or the Dock, select System Preferences.

2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

3. Select Driver or Options.
You see a screen like this:

General '.!'-'I-'r'l‘l." Supply Levels  Utility

To taior full advantage of your printers options, condinm that they are accurately shown

e, For 5"'-'_‘}""'5}1 =t oo yeRr pirber and its optional hordware, Check the prinlers
OO rTation.

Thick papor and envolopes: | Off

Sidp Black Page: | O4f

Quit Moge: | O4f

High Speed Printng: |~ On

Output decumbnts for filing: | O4f

Warning Notifications: |~ On

Establish bidirectional comaunication: |~ On

DobopoooeE

Lowor Casseties MNone

concol | (TN
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4. Select any of the available printing preferences.

5. Click OK.

Printing Preferences - Mac

Parent topic: Printing with the Epson Standard Printer Software - Mac
Printing Preferences - Mac

You can select from these settings on the Options or Driver tab.

Thick Paper and Envelopes
Prevents ink from smearing when you print on envelopes or other thick paper.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Quiet Mode
Lessens noise during printing but may decrease print speed.

High Speed Printing
Speeds up printing but may reduce print quality.

Output documents for filing
Outputs all landscape, portrait, 1-sided, and 2-sided documents in the same orientation for easier
filing.

Warning Notifications

Lets you choose whether or not to receive warning notifications from the printer software for various
operating conditions.

Establish bidirectional communication
Allows the product to communicate with the computer. Do not change the default setting unless you
experience issues when using a shared printing pool.

Lower Cassette
Specifies whether the optional cassette is present.

Parent topic: Selecting Printing Preferences - Mac

Printing Your Document or Photo - Mac
Once you have selected your print settings, you are ready to print.
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Click Print at the bottom of the print window.

Print Settings -

(4]

Paper Source: Auto Select

Media Type: Plain Paper [ Bright White Paper

¥

Print Quality: Normal

¥

F Advanced Settings:

Cancel Print

Checking Print Status - Mac
Parent topic: Printing with the Epson Standard Printer Software - Mac
Checking Print Status - Mac
During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.
You see the print status window:

[ SN ] =| EPSON

o~
"\-F'II e

Pause Sottings

Document. pdf

Printing = Copy 1 0f 1, Page 8 of 14, Shoot 8 of 14,
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2. Select the following options as necessary for your Mac OS version:
» To cancel printing, click the print job and click I:I or Delete.

* To pause a print job, click the print job and click I:' or Hold. To resume a print job, click the
paused print job and click |:| or Resume.
* To pause printing for all queued print jobs, click Pause or Pause Printer.
» To display other printer information, click Settings, Printer Settings, or Supply Levels.
Parent topic: Printing Your Document or Photo - Mac

Printing with the Epson Universal Print Driver - Windows

You can print with the Epson Universal Print Driver using any Windows printing program, as described in
these sections.

Synchronizing Printer Settings - Epson Universal Print Driver - Windows
Selecting Print Settings - Epson Universal Print Driver - Windows
Selecting Default Print Settings - Epson Universal Print Driver - Windows
Locking Printer Settings - Epson Universal Print Driver - Windows
Adding Network Printers - Epson Universal Print Driver - Windows

Parent topic: Printing from a Computer

Synchronizing Printer Settings - Epson Universal Print Driver - Windows
You may need to synchronize the printer driver with the product if the printer driver does not detect the
correct information or settings from the product.

Note: You must sync the printer driver before you can use any optional equipment installed on the
product, such as an optional cassette unit.

1. Do one of the following:

* Windows 10: Click E and select k4 (Settings) > Devices > Printers & scanners. Select
EPSON Universal Print Driver and select Manage > Printer properties.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.
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* Windows 7: Click E’ and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

* Windows Vista: Click E’ and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.
2. Click the Optional Settings tab.

You see this window:

% EFS0M Unieersal Print Divver Properties =

Gersrl  Sharrg  Posts Advenced  Color Management  Secuty  Opbona Se8mgs  Verson infomation

% Prieyies LIty

B etk prter search
A

: B Driver Setings

Current Printer nformaton

Printer [nformabon

Pririber Ty A

Iyt Py () Apguire from Printer Get
Musdhel Piama

W vy Cpsnal informaton
Printer Moded

AdLether Moruchroens (Standand Resoiul

Defmdt of Prnter Contral Linguagt Lt Manual Sattngs

EXCPR
At Duplewer Instaled

Instaled
[t P A .

e
L4 >

DK Carscel : Helg

3. Make sure Acquire from Printer is selected and click Get.

Note: Select the Only Optional Information checkbox if you only want to enable optional
equipment, such as an optional cassette unit.

The product's settings and other information appears in the Current Printer Information area.
4. Click OK.
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Parent topic: Printing with the Epson Universal Print Driver - Windows

Related tasks
Enabling the Optional Paper Cassette - Windows

Selecting Print Settings - Epson Universal Print Driver - Windows
Select the basic settings for the document or photo you want to print.

Note: The names of settings on the universal print driver screens may vary slightly, depending on the
version of the print driver you have installed.

Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select EPSON Universal Print Driver as the printer you want to use.

Note: You may also need to select Properties or Preferences to view your print settings.
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You see the Main tab of your printer settings window:

&% Prsting Preferences ®

Wan Mo Optons Mantenance

Printing Presels Pagpeer Sounce At Select -
Add Remdve Precets.,. Creeciamien® Soe Lether (2 12 x 11in) -
=] Document - Standard
<2l Document - 245 Craeritanon (CPertrmst (W Lareage
£l Decument « 2.5ded
L) Document - 2-5ded with 24Up Paper Tipe Flain Paper | Bright White Paper e
Cuaslity Standand ~

IadedPrntng  |OFF L

Settra...
Muin o off b
— Copes r EAcolate
ll_] . . EAmeverse Qrder
—_— A ool
= ]rint Freview ] 3ok derrarger Lite
Show Setangs
Refet Defpuits

[ox ]| cmes |[ bee

Note: For more information about a setting, right-click it and select Help.

For the Paper Source setting, select where you loaded the paper you want to print on.
Select the size of the paper you loaded as the Document Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.
Select the type of paper you loaded as the Paper Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

Select any of the available print options.
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8. To select a variety of additional layout and printing options for your document or photo, select the
More Options tab and select the printing options you want.

9. To select maintenance and other optional settings, select the Maintenance tab and select the
options you want.

Parent topic: Printing with the Epson Universal Print Driver - Windows

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Related references

Paper Source Options - Windows

Print Quality Options - Windows

Multi-Page Printing Options - Windows

Paper or Media Type Settings - Printing Software
Image Options and Additional Settings - Windows
Header/Footer Settings - Windows

Selecting Default Print Settings - Epson Universal Print Driver - Windows

When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Do one of the following:

« Windows 10: Click Il and select (Settings) > Devices > Printers & scanners. Select
EPSON Universal Print Driver and select Manage > Printing Preferences.

+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Print Preferences.

* Windows 7: Click EI' and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printing Preferences.

* Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
right-click EPSON Universal Print Driver, and select Printing Preferences.

128



You see the printer settings window:

=

Man  More Options  Manterance

Printing Presels Pagpeer Sounce At Select -
Add Remdve Precets.,. Creeciamien® Soe Lether (2 12 x 11in) -
=] Document - Standard
] Cecument - 24 Orentaton @) Pertain Civenscace
£ Decumment « 2-5uded
L) Document - 2-5ded with 24Up Paper Tipe Flain Paper | Bright White Paper e
Cuaslity Standand ~

IadedPrntng  |OFF L

Settrg...
— W P e o e
E Copees i = B Colate
u "_'id-’l '_“.Adkl EAReverse Cnder
Show Setengs (et Previe [ 3k arranger Lie
Foeet D fguits
QK Canscel . Helgy

Note: For more information about a setting, right-click it and select Help.

2. Select the print settings you want to use as defaults in all your Windows programs.
3. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Parent topic: Printing with the Epson Universal Print Driver - Windows

Locking Printer Settings - Epson Universal Print Driver - Windows

Administrators can lock some printer settings to prevent unauthorized changes.
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1. Do one of the following:

* Windows 10: Click I:I and select k=4 (Settings) > Devices > Printers & scanners. Select
EPSON Universal Print Driver and select Manage > Printer properties.

+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 7: Click E and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

* Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.

2. Click the Optional Settings tab.
3. Click Driver Settings.
You see this window:

Aeset Defmiis | e S Fealp

4. Select the checkbox for the settings you want to lock. To lock all print settings, select All Document
Settings.
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5. Under Advanced Settings, select the setting option you want to use for each locked setting.

6. Click OK.

Epson Universal Print Driver Locked Setting Options

Parent topic: Printing with the Epson Universal Print Driver - Windows

Epson Universal Print Driver Locked Setting Options

Select the options you want to use for any locked print settings.

Setting

Options

Description

Watermark

Various text

Lets you select the text for the watermark or prohibit

watermarks watermarks

Add/Delete Lets you add or delete a customized text or image-based
watermark

Settings Lets you select the size, position, and other watermark
settings

Header/Footer Off Prohibits headers or footers

On Allows headers and footers
Settings Lets you select the text and position for printing headers and
footers

2-sided printing | Off Allows printing on only one side of the paper

On Allows printing on both sides of the paper
Multi-Page Off Prohibits multi-page settings

2-Up Allows printing of 2 pages on one sheet of paper

4-Up Allows printing of 4 pages on one sheet of paper

Parent topic: Locking Printer Settings - Epson Universal Print Driver - Windows

Adding Network Printers - Epson Universal Print Driver - Windows
You can use the Epson Universal Print Driver to find and add network printers.
1. Do one of the following:

* Windows 10: Click IEI and select k¥4 (Settings) > Devices > Printers & scanners. Select
EPSON Universal Print Driver and select Manage > Printer properties.
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+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click EPSON Universal Print Driver and select Printer properties.

* Windows 7: Click E and select Devices and Printers. Right-click EPSON Universal Print
Driver and select Printer properties.

* Windows Vista: Click E and select Control Panel. Click Printer under Hardware and Sound,
then right-click EPSON Universal Print Driver and select Properties.
2. Click the Optional Settings tab.

You see this window:

i EPS0M Unreersal Prnk Dirver Properties =

Gersrdl  Shaergy Posts  Advenced Color Management  Secuty  Optond Se8ngs  Verson infomation

& Pririber Litlisy

=2 ﬂ.‘ Network printer search
=1

S
: h Drrver Satings

Current Prirter Iriformaton

Provier [nformaibon

Priciier Ty #

Iyt Privber () oguire from Printer Get
Mindel Hiame

W vy Opssl tnfrmatan
Printer Moded

AdLeiter Morchrome (Sandard Resolul

Diefimit of Printer Contrl Language (. Manual Settrgs

ECPR
dastn Dupkewer Instaled

Instaled
Candemy ok -

e,
< ¥

QK Canscel : Helgy

3. Click Network printer search.
4. When you see the search results, select Add found printers.
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You see a screen like this:

%.1 EPS0N Universal Print Denver 7 by

() Changs connected prrter Fiadresh

(®) Add found printers

Selact printers from the following list, and then dick the ‘Add to Printer Folder" buston, (You can

select multiple prinders from the kst )

Found Prinbens: Search Options
Madel Mame IP Address MAC Addresa Lescation g
WF 192.168.1.121 SCAEDIABCITY
WP 1592168.1.114 DOZEABFICOET
'Wodk Force 192.168.1.108 D026ABE3E42E
W 192.168.1.119 G4EBBC 255106
WF- 152.168,1,125 SCAEDAABCED
XP. 192.168.1.113 FEDO2TDC40ND
g 10T 100 1 YA ST ACNICCE AT o
< >

Add i Prinber Folder Dhsplary Ssttings

Frinters o be added:

Hame of added printer IF Address
< ¥
Sebect a perder from the st 10 s6t R 29 the defaull prnter

Help 0K o

Select the printer or printers you want to add.
6. Click Add to Printer Folder.

The selected printer or printers appear in the lower section of the screen.
7. Select the checkbox next to the product you want to make your default printer, if necessary.
8. Click OK.

Parent topic: Printing with the Epson Universal Print Driver - Windows
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Printing with the PostScript (PS3) Printer Software - Windows

You can print with the PostScript (PS3) printer software using any Windows printing program, as
described in these sections.

Note: The PostScript printer software supports products that are connected via Ethernet. If your product
is connected via USB, you will need to install the standard Epson printer software. To download the
standard Epson printer software, visit epson.com/support (U.S.), epson.ca/support (Canada), or
epson.com.jm/support (Caribbean) and select your product.

Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
Selecting Print Settings - PostScript Printer Software - Windows

Selecting Default Print Settings - PostScript Printer Software - Windows
Accessing Printer Properties - PostScript - Windows

Parent topic: Printing from a Computer

Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows

If you installed optional paper cassette units, you need to enable the optional cassette units before you
can use them with the PS3 printer software.

1. Do one of the following:

* Windows 10: Click E and select k¥4 (Settings) > Devices > Printers & scanners . Select your
product name and select Manage > Printer properties.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Printer properties.

* Windows 7: Click E]' and select Devices and Printers. Right-click your product name and select
Printer Properties.

+ Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click your product name, and select Properties.

2. Click the Device Settings tab.
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You see a window like this:

& EPSON %
General Sharng Pode  Advanced Color Management Sacurty Device Seftings

| EPSON
#1392 Font Substitution Table
32767 [
Qutput Pratocol: ASCH
Send CTRL-D Before Each Jok: Mo
Send CTRL-D After Each Job: Yes
Convert Gray Text to PestScript Gray: No
Convert Gray Graphics to PostScript Gray: Ne
Add Eure Currency Symbol te PostSeript Fonts: No
Job Timeout: 0 séconds
Wait Timeout: 0 seconds
Minimum Font Size to Download a5 Qutline: 100 pixelis
Maximum Font Size to Download as Bitmap: 500 pixelis)
- Installable Options
Lower Cassette Lnit: Mone

[ok ][ conce

L=

3. Select the number of optional cassettes installed as the Lower Cassette Unit setting.
4. Click OK.

The optional paper cassettes are now enabled.

Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Selecting Print Settings - PostScript Printer Software - Windows
Select the basic settings for the document or photo you want to print.
The PostScript printer software supports plain paper printing on these paper and envelope sizes:
+ Letter (8.5 x 11 inches [216 x 279 mm])
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A4 (8.3 x 11.7 inches [210 x 297 mm])

Legal (8.5 x 14 inches [216 x 356 mm])

A6 (4.1 x 5.8 inches [105 x 148 mm])

B6 (5 x 7.2 inches [128 x 182 mm])

Executive (7.25 x 10.5 inches [184 x 267 mm])

Folio (8.5 x 13 inches [216 x 330 mm])

No. 10 (4.1 x 9.5 inches [105 x 241 mm)])
Open a photo or document for printing.
Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

If necessary, select your product name as the printer you want to use, and then click the
Preferences button.
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You see the Layout tab of your printer settings window:

% EPS0N P53 Serugs Praniesg Prefidended

PoperQualty Lot Job Seliecs

Crmratory
'_' Pertran w

Prrt o Eloth Safes
(2] tone :
Fape Crider

o ” .

Page Format
(®) Fages par Sheet I 1

Pages per Sreet Layout
Right then Down W

(Z) Book et

Jn Lett Edes

o] [ conce
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Select the print options as necessary.
Click the Paper/Quality tab.
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You see this window:

& EPEON P53 Serugs Pranieeg Prefidended 4
Poper/Cuslty Lot Job Seltnge
Tewy Selection

Papes Source: =7 Rear Papte Feed -

Pleduy: Ertlope

Advanced.

I -

Select the Paper Source that matches where you loaded the paper you want to print on.
Select the Media type that matches the paper you loaded.

8. To select additional layout and printing options, select Advanced and select additional settings as
necessary.

Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Related references
Paper Source Options - Windows
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Selecting Default Print Settings - PostScript Printer Software - Windows

When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Do one of the following:

* Windows 10: Click IEI and select k¥4 (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printing preferences.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name and select Print Preferences.

* Windows 7: Click E]' and select Devices and Printers. Right-click your product name and select
Printing Preferences.

+ Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, and select Printing Preferences.

2. Click the Layout tab.
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You see the printer settings window:

% Painleng Prefalended =

PoperQualty Loyt Joh Selircs
Crmratory
'_' Pertran w
Prrt o Elgth Safes
Fape Crider
Froet to Back, -
Page Format
(#) Fages poar Sheet 1w

Pages per SFeet Layout
Right then Down w

(Z) Book et

o ][ conce

3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Accessing Printer Properties - PostScript - Windows
You can access the printer properties to view and change product settings for PostScript printing.
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1. Do one of the following:

* Windows 10: Click E and select k=4 (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printer properties.

+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click the postscript driver for your product, and select Printer
properties.

* Windows 7: Click E]' and select Devices and Printers. Right-click the postscript driver for your
product and select Printer properties.

* Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
then right-click the postscript driver for your product and select Properties.
2. Click any tab to view and change the printer property settings.
Parent topic: Printing with the PostScript (PS3) Printer Software - Windows

Printing with the PostScript (PS3) Printer Software - Mac

You can print with the PostScript (PS3) printer software using any Mac printing program, as described in
these sections.

Note: The PostScript printer software supports products that are connected via Ethernet. If your product
is connected via USB, you will need to install the standard Epson printer software. To download the
standard Epson printer software, visit epson.com/support (U.S.), epson.ca/support (Canada), or
epson.com.jm/support (Caribbean) and select your product.

Enabling the Optional Paper Cassettes - PostScript Printer Software - Mac
Selecting Print Settings - PostScript Printer Software - Mac

Parent topic: Printing from a Computer

Enabling the Optional Paper Cassettes - PostScript Printer Software - Mac

If you installed optional paper cassette units, you need to enable the optional cassette units before you
can use them with the PS3 printer software.

1. Inthe Apple menu or the Dock, select System Preferences.

2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

3. Select Driver or Options.
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You see a screen like this:

Genaral M Supply Lovels

To take fhull advantage of your printers aptions, confinm that thay 4 accuratoly thown
here. For information on wour prinker and s optional hardware, check the pricter's
documeniation.

Lower Cassotle Unit: | None B

Cancel | QLI

4. Select the number of optional cassettes installed as the Lower Cassette Unit setting.
5. Click OK.

The optional paper cassettes are now enabled.

Parent topic: Printing with the PostScript (PS3) Printer Software - Mac

Related tasks
Enabling the Optional Paper Cassette - Mac

Selecting Print Settings - PostScript Printer Software - Mac
Select the basic settings for the document or photo you want to print.
The PostScript printer software supports plain paper printing on these paper and envelope sizes:
* A4 (8.3 x 11.7 inches [210 x 297 mm])
+ Letter (8.5 x 11 inches [216 x 279 mm])
* No. 10 (4.1 x 9.5 inches [105 x 241 mm])
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A6 (4.1 x 5.8 inches [105 x 148 mm])
B6 (5 x 7.2 inches [128 x 182 mm)])
Executive (7.25 x 10.5 inches [184 x 267 mm])
Legal (8.5 x 14 inches [216 x 356 mm])
Folio (8.5 x 13 inches [216 x 330 mm])
Open a photo or document for printing.
Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

Select your product as the Printer setting.

Printer: EPSON

L

Prasets: Default Settings

L]

If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.
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You see the expanded printer settings window for your product:

Printer: EPSON

(o

Presets: Default Settings

Copies: 1 Two-Sided

Pages: © All
Selected Page in Sidebar
From: |1 to: 1

Paper Size: WUS Letter E B.50 by 11.00 inches

Orientation: Ii} T

Preview E

Auto Rotate Show Notes
Scale:
D 5cale to Fit: O Print Entire Image

Fill Entire Paper

Copies per page: 1 E

Cancel m

Note: The print window may look different, depending on the Mac OS version and the application
you are using.

5. Select the Two-Sided, Copies, and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
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6. Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

7. Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

8. Select Paper Feed from the pop-up menu.

Preview

Layout
Color Matching
Paper Handling

¥ Paper Feed

Cover Page

Printer Features

You see these settings:

<

Paper Fead

* All Pages From:  Auto Select <
First Page From: Rear Paper Feed

Remaining From: Rear Paper Feed

Cancel Print

9. Select All Pages From or First Page From and select the paper source you want to print from.
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10. Select Printer Features from the pop-up menu.

Preview

Layout

Color Matching
Paper Handling
Paper Feed
Cover Page

You see these settings:

Printer Features E

Feature Sets: Quality E

Media Type: = Plain H

Print Quality: = Fine H

11. Select Plain as the Media Type setting.
12. Select one of the following Print Quality options:
» For fast printing with reduced quality, select Fast.
» For printing text and graphics with good quality and print speed, select Fine.
» For the best printing with reduced speed, select Maximum.
13. Select any of the following from the pop-up menu as necessary:
» Select Layout to adjust a variety of layout options for your document or photo.
+ Select Paper Handling to adjust the size of the image as you print it.
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+ Select Color Matching to fine-tune the colors in your printout.
Parent topic: Printing with the PostScript (PS3) Printer Software - Mac

Related tasks
Selecting Basic Print Settings - Mac

Cancelling Printing Using a Product Button
If you need to cancel printing, press the @ Stop button.
Parent topic: Printing from a Computer
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Replacing Ink Supply Units (Ink Packs) and Maintenance
Boxes

When ink is expended in an ink pack or the maintenance box is at the end of its service life, you need to
replace it. The maintenance box stores ink that gets flushed from the system during print head cleaning.

Note: Please dispose of your used Epson branded ink packs and maintenance boxes responsibly and in
accordance with local requirements. If you would like to return your used ink packs and maintenance
boxes to Epson for proper disposal, please go to epson.com/recycle for more information.

Check Ink and Maintenance Box Status

Purchase Epson Ink Packs and Maintenance Boxes
Removing and Installing Ink Packs

Maintenance Box Replacement

Check Ink and Maintenance Box Status

Your product and its software will let you know when ink is low or expended, or when the maintenance
box needs to be replaced.

Note: When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product,
you can check ink and maintenance box status by using the product buttons or the utilities included with
the standard Epson printer software. To download the standard Epson printer software, visit
epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select
your product.

Checking Ink Status on the LCD Screen
Checking Ink and Maintenance Box Status - Windows
Checking Ink and Maintenance Box Status - Mac

Parent topic: Replacing Ink Supply Units (Ink Packs) and Maintenance Boxes

Checking Ink Status on the LCD Screen

When your ink pack is low or expended, you see a message on the LCD screen. Select How To and
follow the steps on the LCD screen to replace the ink pack.

You can also check the status of the ink pack and maintenance box from the product control panel.
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1. Press the 0" home button, if necessary.
2. Select the & icon.
You see a screen like this:

Supply Status

Ink Level
BK | |

Remaining capacity
of Maintenance box

Note: The displayed ink and maintenance box levels are approximate.

Parent topic: Check Ink and Maintenance Box Status

Related concepts
Maintenance Box Replacement

Related tasks
Removing and Installing Ink Packs

Checking Ink and Maintenance Box Status - Windows

A low ink reminder appears if you try to print when ink is low. You can also check your ink or
maintenance box status at any time using a utility on your Windows computer.

1. To check your status, access the Windows Desktop and double-click the 3'-’ icon for your product in
the right side of the Windows taskbar, or click the up arrow and right-click 3'-’ Then click Details.
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You see this window:

B EPSOM Status Monitor 3 -

EPSON "%

It ready to prnt.

Trifesrena S

Marbenancoe Box Service Life

Print Qussss 0K

2. Replace or reinstall the maintenance box or ink pack as indicated on the screen.

Note: If the ink pack installed in the product is broken, incompatible with the product model, or
improperly installed, Epson Status Monitor will not display an accurate ink status.

3. To disable promotional offers, right-click the product icon in the Windows taskbar and select
Monitoring Preferences.
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You see this window:

Monitoring Preferences ? *

Select Notification

Event Saeen Nobficaton s
B Error

[0 Commamication Error
B Printer Selection Error
O Inik Low

299¢9

] simple status notification Defaudt

Select Shortout Toon
Flregster the shortout icon to the taskbar

Double-cicking the Shortout Icon
opens the Printer Status Window.

:

[(] alovw monitoring of shared printers

[+ Display Epson Offers
[ Share my usage information with Epson

[o] [ o o

4. Deselect the Display Epson Offers checkbox.
Parent topic: Check Ink and Maintenance Box Status
Related concepts

Maintenance Box Replacement

Related tasks
Removing and Installing Ink Packs

Checking Ink and Maintenance Box Status - Mac

You can check the status of your ink and maintenance box using a utility on your Mac.
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In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

Select EPSON Status Monitor.
You see this window:

EPSON eson

!: EPSON Status Monitor

Iri Lvwapl

Back

Information

Mamienanco Box Senvice Lifte

Update ] 4

Do the following as necessary:
* You can update the ink and maintenance box status by clicking Update.
* Replace or reinstall the maintenance box or an ink pack as indicated on the screen.

Note: If an ink pack installed in the product is broken, incompatible with the product model, or
improperly installed, Epson Status Monitor will not display an accurate ink status.
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Parent topic: Check Ink and Maintenance Box Status
Related concepts
Maintenance Box Replacement

Related tasks
Removing and Installing Ink Packs

Purchase Epson Ink Packs and Maintenance Boxes

You can purchase genuine Epson ink, maintenance boxes, and paper at epson.com (U.S. sales),
epson.ca (Canadian sales), or epson.com.jm (Caribbean sales). You can also purchase supplies from
an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S.
or 800-807-7766 in Canada.

Note: This printer is designed for use with Epson ink packs only, not third-party ink packs or ink. Other
brands of ink supplies are not compatible and, if described as compatible, may not function properly or
continuously. Such restrictions can be avoided with some other printers such as Epson EcoTank
cartridge-free printers.

The included initial ink pack is designed for reliable printer setup and cannot be used as a replacement
ink pack or resold. After setup, the remaining ink is available for printing. Yields are based on ISO 24711
in default mode, printing continuously. Yields vary due to print images, settings, and temperatures.
Printing infrequently reduces yields. Your ink pack must be installed with ink for printing and printer
maintenance. For print quality, some ink remains in the replaced ink pack.

Ink Supply Unit (Ink Pack) Part Numbers
Parent topic: Replacing Ink Supply Units (Ink Packs) and Maintenance Boxes

Ink Supply Unit (Ink Pack) Part Numbers

Use these part numbers when you order or purchase new ink packs.
Maintenance box part number: T6716

Ink color Part number
Standard-capacity High-capacity Extra High-capacity
Black M02 MO02XL MO2XXL

Parent topic: Purchase Epson Ink Packs and Maintenance Boxes
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Removing and Installing Ink Packs

Make sure you have your replacement ink pack handy before you begin. You must install a new ink pack
immediately after removing the old one.

1. Iftheink pack is low or expended, you see a message on your product's LCD screen and on your
computer screen.

2. Unlock and open the front cover.

4. Remove the used ink pack from the tray.

Note: Dispose of used ink packs carefully. Do not take the used ink pack apart or try to refill it.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. Seek medical advice if problems persist. If ink gets into your
mouth, spit it out and see a doctor right away. Keep ink packs out of the reach of children.
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Shake the new ink pack 10 times and remove it from the packaging.

Caution: Do not touch the green chip on the ink pack.

Insert the new ink pack into the ink pack tray as shown. Place the ink pack into the ink pack tray and
move the handle forward to make sure the ink pack sets correctly.
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7. Make sure the top of the ink pack is level with the top of the tray and move the handle back to its
original position.

8. Slide the ink pack tray into the product until it clicks.

Note: If you cannot insert the tray all the way, make sure the top of the ink pack is level with the top
of the tray.
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9. When you are finished, close and lock the front cover.

v —

10. Follow the on-screen instructions to charge your product's ink.

Parent topic: Replacing Ink Supply Units (Ink Packs) and Maintenance Boxes

Related concepts
Purchase Epson Ink Packs and Maintenance Boxes

Maintenance Box Replacement

The maintenance box stores surplus ink that gets flushed from the system during print head cleaning.
When you see a message on the LCD screen, follow the on-screen instructions to replace the
maintenance box.

Note the following precautions when replacing the maintenance box:

Do not remove the maintenance box or its cover except when replacing the maintenance box.
Do not touch the green chip on the side of the maintenance box.

Do not tilt the maintenance box after removing it or ink may leak.

Do not touch the openings in the maintenance box or you may get ink on you.

Do not drop the maintenance box or subject it to strong shocks.

If you cannot replace the cover, the maintenance box may not be installed correctly. Remove and
reinstall the maintenance box.

Do not store the maintenance box in high or freezing temperatures.

Caution: Do not reuse a maintenance box that has been removed and left uninstalled for a long period.
Keep the maintenance box away from direct sunlight.
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Note: The maintenance box is a user-replaceable part and is not covered by the product warranty.

Parent topic: Replacing Ink Supply Units (Ink Packs) and Maintenance Boxes

Related concepts
Purchase Epson Ink Packs and Maintenance Boxes
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Adjusting Print Quality

If your print quality declines, you may need to run a utility to clean or align the print head.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

Note: When using the Epson Universal Print Driver or PostScript (PS3) printer software with the product,
you can clean the print head, adjust the print quality, and run a nozzle check by using the product
buttons or the utilities included with the standard Epson printer software. To download the standard
Epson printer software, visit epson.com/support (U.S.), epson.ca/support (Canada), or
epson.com.jm/support (Caribbean) and select your product.

If running these utilities does not solve the problem, you may need to replace the ink pack.

Print Head Maintenance
Print Quality Adjustment
Print Head Alignment
Cleaning the Paper Guide

Print Head Maintenance

If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.
Note: You cannot clean the print head if ink is expended, and may not be able to clean it when ink is low.

Print Head Nozzle Check
Print Head Cleaning

Parent topic: Adjusting Print Quality

Related topics
Replacing Ink Supply Units (Ink Packs) and Maintenance Boxes
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Print Head Nozzle Check

You can print a nozzle check pattern to check for clogged nozzles.

Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility

Parent topic: Print Head Maintenance
Checking the Nozzles Using the Product Control Panel
You can check the print head nozzles using the control panel on your product.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Press the 9 home button, if necessary.
4. Select Maintenance > Print Head Nozzle Check.
You see a screen like this:

Print Head Nozzle Check

Load Letter/A4 size paper in the C1
to Nozzle Check Pattern.

5. Select Print.
The nozzle pattern prints.
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6. Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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7. Do one of the following:
+ If there are no gaps, select O

+ If there are gaps or the pattern is faint, select x and continue.

8. Follow the instructions on the screen to clean the print head, check the nozzles, and repeat the
process as necessary.

Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not
be able to print.

If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without
printing. Then try cleaning the print head again. If quality still does not improve, contact Epson.
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Parent topic: Print Head Nozzle Check

Related concepts
Print Head Cleaning

Related topics
Loading Paper

Checking the Nozzles Using a Computer Utility

You can check the print head nozzles using a utility on your Windows or Mac computer.

1.
2.
3.

Make sure there are no errors on the LCD screen.
Load a few sheets of plain paper in the product.
Do one of the following:

* Windows: Access the Windows Desktop and right-click the & icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click T )

* Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

Select Nozzle Check.
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You see a window like this:

#] Mozzle Check *

To perform a nozze chedk, make sure that the printer is on and
connected to the computer, Also make sure that A4 or Letter size plan
paper i loaded in the rear paper feed or the paper cassette. Chck
[Print] to print & nozzle check pattern or dick [Cancel] to quit.

et |[om ]

Click Print.
Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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Print head needs cleaning
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7. Ifthere are no gaps, click Finish.

Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not
be able to print.

If there are gaps or the pattern is faint, clean the print head.

If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without
printing. Then try cleaning the print head again. If quality still does not improve, contact Epson.

Parent topic: Print Head Nozzle Check

Related concepts
Print Head Cleaning

Related topics
Loading Paper

Print Head Cleaning

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You cannot clean the print head if ink is expended, and may not be able to clean it when ink is low.

Cleaning the Print Head Using the Product Control Panel
Cleaning the Print Head Using a Computer Utility
Enabling the Periodic Cleaning Setting
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Parent topic: Print Head Maintenance

Related tasks
Removing and Installing Ink Packs

Cleaning the Print Head Using the Product Control Panel
You can clean the print head using the control panel on your product.
1. Make sure there are no errors on the LCD screen.
2. Load afew sheets of plain paper in the product.
3. Press the 9r home button, if necessary.
4. Select Maintenance > Print Head Cleaning.
You see a screen like this:

Print Head Cleaning

Clean the print head to correct
missing dots.

Start

5. Select Start to clean the print head.
When the cleaning cycle is finished, you see a message on the screen.

Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not
be able to print.

6. Select Check to print a nozzle check pattern and confirm that the print head is clean.
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7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without
printing. Then try cleaning the print head again. If quality still does not improve, contact Epson.

Parent topic: Print Head Cleaning

Related topics
Loading Paper

Cleaning the Print Head Using a Computer Utility
You can clean the print head using a utility on your Windows computer or Mac.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
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3. Do one of the following:

* Windows: Access the Windows Desktop and right-click the !U icon for your product in the right
side of the Windows taskbar, or click the up arrow and right-click !U

* Mac: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

4. Select Head Cleaning.
You see a window like this:

% Head Cleaning w

\,Q; Chick [Start] to dean the print head nozzles. Because deaning
consumes some ink, only dean the print head when faint areas or
QApS BppEar in your printout, Use the Nozzde Check” utiity first to
confirm that the print bead needs to be deaned, IF the ink is low o
expended, replace the ink supply unit first.

=

5. Click Start to begin the cleaning cycle.

The O power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is
finished.
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Caution: Never turn off the product or open the front cover during a cleaning cycle or you may not
be able to print.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.

7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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+ If there are no gaps, click Finish.
« If there are gaps or the pattern is faint, click Clean to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours without
printing. Then try cleaning the print head again. If quality still does not improve, contact Epson.

Parent topic: Print Head Cleaning
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Related topics
Loading Paper

Enabling the Periodic Cleaning Setting

You can set the product to automatically check and clean the print head nozzles. By routinely checking
and cleaning the print head nozzles, you can better maintain premium print quality.

1. Press the 90 home button, if necessary.

2. Select Maintenance > Periodic Cleaning.

3. Select On to enable the Periodic Cleaning setting.
Parent topic: Print Head Cleaning

Print Quality Adjustment

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to adjust the print quality.

Note: Banding may also occur if your print head nozzles need cleaning.

Adjusting the Print Quality Using the Product Control Panel
Parent topic: Adjusting Print Quality

Adjusting the Print Quality Using the Product Control Panel
You can adjust the print quality using the control panel on your product.
1. Make sure there are no errors on the LCD screen.
2. Load a few sheets of plain paper in the product.
3. Press the 9 home button, if necessary.
4. Select Maintenance.
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You see a screen like this:

Maintenance

Print Quality

’EA"E"" Adju slment i
Prinl Head Nozzle ﬂ
Check

/%7 Print Head Cleaning (@

T romaion O |

Select Print Quality Adjustment.

Follow the on-screen instructions to print an alignment sheet.
Note: Do not cancel printing while you are printing head alignment patterns.

Check the printed patterns on the alignment sheet and select the following on the LCD screen:

» For pattern 1, select the number representing the pattern with the least amount of separation or
overlap.

#1

I@II
1 3 4
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» For patterns 2 and 3, select the number representing the pattern with the least misaligned vertical
line.

» For patterns 4 and 5, select the number representing the pattern with the least amount of
separation or overlap.

\A 4

R |
R | >
.

)
> "

£

8. Select Proceed.
Parent topic: Print Quality Adjustment

Related topics
Loading Paper

Print Head Alignment

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.
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Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using the Product Control Panel

Parent topic: Adjusting Print Quality

Aligning the Print Head Using the Product Control Panel

You can align the print head using the control panel on your product.

1.

o~ b

Make sure there are no errors on the LCD screen.

Load a few sheets of plain paper in the product.

Press the 90 home button, if necessary.

Select Maintenance > Print Head Alignment.

Select one of the following options:

* Ruled Line Alignment if your printout is blurry.

» Horizontal Alignment if your printout contains horizontal banding.
Follow the on-screen instructions to print an alignment sheet.

Note: Do not cancel printing while you are printing head alignment patterns.

Check the printed patterns on the alignment sheet and select the following on the LCD screen,
depending on the alignment pattern you printed:

* Ruled Line Alignment: Select the number representing the pattern with the least amount of
separation or overlap.

#1
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Select the number representing the pattern with the least misaligned vertical line.

* Horizontal Alignment: Select the number representing the pattern with the least amount of
separation or overlap.

8. Select Proceed.
Parent topic: Print Head Alignment

Related topics
Loading Paper

Cleaning the Paper Guide

If you see ink on the back of a printout, you can clean the paper guide rollers to remove any excess ink.
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1. If printouts are smeared or scuffed, load plain paper in the paper source that you want to clean in
one of these sizes: Letter (8.5 x 11 inches [216 x 279 mm)]) or A4 (8.3 x 11.7 inches
[210 x 297 mm)]).

Press the 40+ home button, if necessary.

Select Maintenance > Paper Guide Cleaning.

Select the paper source you want to clean.

Follow the on-screen instructions to clean the paper guide.

o ok wbd

Repeat these steps as necessary until the paper comes out clean.

Note: If the paper is still smeared or scuffed, repeat these steps to clean the other paper sources.

Parent topic: Adjusting Print Quality

Related topics
Loading Paper
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Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.

Cleaning Your Product
Transporting Your Product

Cleaning Your Product
To keep your product working at its best, you should clean it several times a year.
Caution: Do not use a hard brush, benzene, alcohol, or paint thinner to clean the product or you may
damage it. Do not use oil or other lubricants inside the product or let water get inside it. Close the rear
paper feed slot when you are not using it, to keep out dust.

Turn off the product.

Wait for the O power light to turn off, then unplug the power cable.
Disconnect any connected cables.
Remove all the paper from the product.

ok~ wbd =

Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical cleansers.
Parent topic: Cleaning and Transporting Your Product

Transporting Your Product

If you need to store your product or transport it a long distance, prepare it for transportation as described
here.
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Caution: During transportation and storage, follow these guidelines:

» Because the product is heavy, two or more people should lift and carry it using the hand positions
shown here:

+ Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.

» Leave the ink pack installed. Removing the pack can dry out the print head and may prevent the
product from printing.

Note: Before storing your product for a long period, replace low, expended, or expired ink to help
prevent the print head from drying out. Store your product in a cool, dry place.

Turn off the product.

Wait for the O power light to turn off, then unplug the power cable.

Disconnect any connected cables.

Remove all the paper from the product.

Lift up the product cover.

S e

Make sure the print head is in the home position on the right.
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Secure the print head to the case with tape as shown.

\\

AR

,
.

Caution: Do not touch the white flat cable inside the product; otherwise, you may damage your
product.

177



8. Lower the product cover.

9. Uninstall the optional paper cassette, if necessary.
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10. Close the rear paper feed slot and output tray and lower the control panel.

11. Remove the output tray.

12. Place the product in its original packing materials, if possible, or use equivalent materials with
cushioning around the product.

Keep the product level during transportation. If print quality has declined when you print again, clean and
align the print head. Make sure you remove the tape securing the print head before using the product.

Parent topic: Cleaning and Transporting Your Product
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Related concepts

Print Quality Adjustment

Print Head Cleaning

Related tasks

Removing and Installing Ink Packs
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Solving Problems

Check these sections for solutions to problems you may have using your product.

Checking for Software Updates

Product Status Messages

Running a Product Check

Resetting Control Panel Defaults

Solving Setup Problems

Solving Network Problems

Solving Paper Problems

Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems

Uninstall Your Product Software

Where to Get Help

Checking for Software Updates

Periodically, it's a good idea to check Epson's support website for free updates to your product software.
Visit epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and
select your product.

Note: Epson periodically provides firmware updates to address issues of security, performance, minor
bug fixes and ensure your printer functions as designed. Your printer was designed to work only with
genuine Epson ink packs, therefore some updates may affect the functionality of third-party ink.

* Windows: Your printer software automatically checks for updates. You can also manually update the
software by selecting Software Update here:
+ Access the Windows Desktop and right-clicking the & icon for your product in the right side of the
Windows taskbar, or clicking the up arrow and right-clicking Bui
+ On the Maintenance tab in the printer settings window

You can also update the software by selecting EPSON Software Updater in the EPSON or EPSON
Software program group, accessible by the Start button, or on the Start or Apps screens, depending
on your version of Windows.
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* OS X: You can manually update the software by opening the Applications > Epson Software folder
and selecting EPSON Software Updater.

* macOS 10.12.x or 10.13.x: You can manually update the software by opening the App Store,
selecting Updates, searching for a software update option for Epson Software, and selecting Update.

Parent topic: Solving Problems

Product Status Messages

You can often diagnose problems with your product by checking the messages and status icons on its

LCD screen.

Note: If the LCD screen is dark, press the screen to wake the product from sleep mode.

LCD screen message

Condition/solution

Printer error. Turn on the printer
again. See your documentation for
more details.

Turn the product off and then back on again. If the error persists,
check for and remove any jammed paper or protective materials
from the product. If the error still persists, contact Epson for
support.

If you see any of the following error codes, make sure you have
not exceeded the loading capacity for any paper source:

+ 000181
+ 000184

Paper out in XX.

Load the size and type of paper in the indicated paper source.

Too many paper cassette units are
installed. Turn the power off and
uninstall the extra units. See your
documentation for details.

You can install one optional paper cassette unit. Remove any
extra units.

Cannot print because XX is out of
order. You can print from another
cassette.

Turn the product off and then back on again. Reinsert the
indicated paper cassette. If the error persists, contact Epson for
support.

You need to replace Ink Supply Unit.

Replace the ink pack.

Paper Setup Auto Display is set to
Off. Some features may not be
available. For details, see your
documentation.

AirPrint is not available when the Paper Setup Auto Display
setting is turned off. Change the Paper Setup Auto Display
setting to On.
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LCD screen message

Condition/solution

The combination of the IP address
and the subnet mask is invalid. See
your documentation for more details.

There is a problem with the network connection to your product.
Set up your product on the network again.

To use cloud services, update the
root certificate from the Epson Web
Config utility.

Access the Web Config utility and update the cloud service root
certificate.

Check that the printer driver is
installed on the computer and that
the port settings for the printer are
correct.

Check that the printer driver is
installed on the computer and that
the USB port settings for the printer
are correct.

On a Windows computer, go to Control Panel > Hardware and
Sound > Devices and Printers. Right-click the printer and
select Printer Properties. Make sure the printer port is selected
correctly in the Ports tab. Select the USBXXX setting for a USB
connection or EpsonNet Print Port for a network connection.

Recovery mode

An error has occurred during firmware updating. Connect your
product using a USB cable and try downloading the Firmware
Update from the Epson support site. If you still need help,
contact Epson for support.

Parent topic: Solving Problems

Related references

Where to Get Help

Related tasks

Removing and Installing Ink Packs
Accessing the Web Config Utility
Checking for Software Updates
Related topics

Wi-Fi or Wired Networking

Running a Product Check

Running a product check helps you determine if your product is operating properly.

1. Disconnect any interface cables connected to your product.

2. Load plain paper in the paper cassette.
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Press the ¥ home button, if necessary.
Select Maintenance.
You see a screen like this:

Maintenance

A o Print Quality
W A Adjustment D)

Print Head Mozzle
Check i ]

/%7 Print Head Cleaning (@

Select Print Head Nozzle Check.
You see a screen like this:

Print Head Mozzle Gheck

Load Letter/A4d size paper in the C1
to Nozzle Check Pattern.

Select Print.

The nozzle pattern prints.
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7. Do one of the following, depending on the results of the product check:

+ If the page prints and the nozzle check pattern is complete, the product is operating properly. Any
operation problem you may have could be caused by your computer, cable, software, or selected
settings. Check the other solutions in this guide or try uninstalling and reinstalling your printer
software.

+ If the page prints but the nozzle check pattern has gaps, clean the print head.

+ If the page does not print, the product may have a problem. Check the other solutions in this
manual. If they do not work, contact Epson.

Parent topic: Solving Problems

Related concepts

Print Head Cleaning

Print Quality Adjustment
Uninstall Your Product Software

Related references
Where to Get Help

Resetting Control Panel Defaults

If you have a problem with settings on the product control panel, you can reset them to their factory
defaults. You can choose which settings to reset or reset them all.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

Press the 90 home button, if necessary.

Select Settings.

Select General Settings.

Scroll down and select System Administration. Enter the administrator password, if necessary.

o k0=

Scroll down and select Restore Default Settings.
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You see a screen like this:

Restore Default Settings

Metwork Sellings
All Except Network Setlings

All Settings

6. Select one of these options:

* Network Settings: Resets all network settings

+ All Except Network Settings: Resets all settings except for network settings

» All Settings: Resets all control panel settings

You see a confirmation screen.
7. Select Yes to reset the selected settings. (Select No if you want to cancel the operation.)
Parent topic: Solving Problems

Solving Setup Problems
Check these sections if you have problems while setting up your product.

Product Does Not Turn On or Off
Noise After Ink Installation
Software Installation Problems

Parent topic: Solving Problems

186



Product Does Not Turn On or Off

If you cannot turn the product on or off, try these solutions:

+ If you cannot turn on your product, make sure the power cord is securely connected and hold down
the power button a little longer.

+ If you cannot turn off your product, hold down the power button a little longer. If you still cannot turn off
your product, unplug the power cord, plug the power cord back in, then turn your product on and off
again using the power button.

Parent topic: Solving Setup Problems

Noise After Ink Installation
If you hear noises from your product after installing ink, check the following:

» The first time you install the ink pack, the product must charge its print head. Wait until charging
finishes before you turn off the product, or it may charge improperly and use excess ink the next time
you turn it on.

+ Ifthe product's print head stops moving or making noise, and the charging process has not finished
after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still
in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems

Software Installation Problems
If you have problems while installing your product software, try these solutions:

* Make sure your product is turned on and any necessary cables are securely connected at both ends. If
you still have problems installing software, disconnect the cable and carefully follow the instructions on
the Start Here sheet. Also make sure your system meets the requirements for your operating system.

» Close any other programs, including screen savers and virus protection software, and install your
product software again.

* In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

+ If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your system administrator.

* If you are printing over a network, make sure your product is set up properly on the network.
Parent topic: Solving Setup Problems
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Related references
Windows System Requirements
Mac System Requirements

Solving Network Problems
Check these solutions if you have problems setting up or using your product on a network.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not
responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network

Product Does Not Appear in Mac Printer Window

Cannot Print Over a Network

Parent topic: Solving Problems

Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

* If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD screen is not lit or does not appear, make sure you select one of the WPS options from
the product control panel within 2 minutes of pressing the WPS button on your router.

* Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid
placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a
filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

» Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.

* You may need to disable the firewall and any anti-virus software on your wireless router or access
point.
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Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
obtain your product's MAC address, print a network status sheet. Then follow the instructions in your
router or access point documentation to add the address to the list.

If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.

If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.

Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.

If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on
your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx connection
settings from your device and enter a new password. See your device documentation for instructions.

Parent topic: Solving Network Problems

Related concepts

Wi-Fi Direct Mode Setup

Related tasks

Selecting Wireless Network Settings from the Control Panel
Printing a Network Status Sheet

Related topics
Wi-Fi or Wired Networking

Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:

Make sure your product is turned on and connected to your network. Verify connection using your
product control panel.

Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-
ASCII characters.

Make sure your product is not connected to a guest network.

If necessary, reinstall your product software and try running EpsonNet Setup again:
1. Reset your product's network settings to their factory defaults.

2. Windows only: Uninstall your product software.
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3. Initialize your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your Internet connection when you
initialize your router, so note the next step before initializing it.

4. Download your product software from the Epson website using the instructions on the Start Here
sheet.

If you have replaced your router, reinstall your product software to connect to the new router.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and

5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions.

Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing detection of your device over the network. See your router or access point documentation
for instructions on disabling the Privacy Separator function.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Related topics
Wi-Fi or Wired Networking

Product Does Not Appear in Mac Printer Window
If your product does not appear in the Mac printer window, try these solutions:

Turn your product off, wait 30 seconds, then turn it back on again.

If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD screen is not lit, make sure you select one of the WPS options from the product control
panel within 2 minutes of pressing the WPS button on your router.

If you are connecting the product wirelessly via EpsonNet Setup and you do not see the Wi-Fi antenna
icon with connection bars on your LCD screen, make sure your product software was installed
correctly. If necessary, reinstall your software.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
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give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for instructions.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Cannot Print Over a Network
If you cannot print over a network, try these solutions:

Make sure that your product is turned on.
Make sure you install your product's network software as described in your product documentation.

Print a network status sheet and verify that the network settings are correct. If the network status is
Disconnected, check any cable connections and turn your product off and then on again.

If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your
network does not assign IP addresses using DHCP, set the IP address manually.

Make sure your computer and product are both using the same wireless network.

If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place
your product closer to your router or access point. Avoid placing your product near a microwave oven,
2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

Check if there are any paused print jobs.
Make sure your printer is selected as the default printer.
Check if the selected printer port is correct.

Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing printing from a device over the network. See your router or access point documentation for
instructions on disabling the Privacy Separator function.

If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD screen is not lit, make sure you select one of the WPS options from the product control
panel within 2 minutes of pressing the WPS button on your router.
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* Check your wired LAN router or access point to see if the LED for the port to which your product is
connected is on or flashing. If the link LED is off, try the following:

» Make sure the Ethernet cable is securely connected to your product and to your router, access
point, switch, or hub.

» Try connecting your product to a different port or a different router, access point, switch, or hub.
+ Try connecting with a different Ethernet cable.
» Try printing to your product from another computer on the network.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. See your router documentation for instructions.

* If you are connecting the product via EpsonNet Setup and the Wi-Fi icon does not appear lit on the
LCD screen, make sure your product software was installed correctly. If necessary, reinstall your
software.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Related tasks
Printing a Network Status Sheet

Related topics
Wi-Fi or Wired Networking

Solving Paper Problems
Check these sections if you have problems using paper with your product.

Paper Feeding Problems
Paper Jams Inside the Product
Paper Ejection Problems

Parent topic: Solving Problems
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Paper Feeding Problems
If you have problems feeding paper, try these solutions:

If paper does not feed for printing, remove it from the rear feed slot or cassette. Reload it, then adjust
the edge guides. Make sure the paper stack is not above the tab on the edge guides inside the
cassette or rear feed slot.

If paper does not feed for printing, remove it from the rear feed slot or cassette. Reload it, then adjust
the edge guides. Make sure the paper stack is not above the arrow mark on the edge guides inside the
cassette or rear feed slot.

Place the product on a flat surface and operate it in the recommended environmental conditions.

Be sure to insert the paper cassette all the way into your product.

If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
Do not load more than the recommended number of sheets.

Make sure your paper meets the specifications for your product.

If paper jams when you print on both sides of the paper, try loading fewer sheets.

Make sure the paper size and paper type settings are correct for the paper source.

If you installed an optional paper cassette unit, be sure to enable the cassette unit in the printing
software.

If your product pauses during printing, make sure the front cover is closed.

For best results, follow these guidelines:

» Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
* Load paper in the cassette printable side down.

* Do not load binder paper with holes in the cassette.

» Follow any special loading instructions that came with the paper.

Parent topic: Solving Paper Problems

Related references

Paper Jams Inside the Product
Paper Loading Capacity
Paper Specifications

Related tasks

Cleaning the Paper Guide
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Related topics
Loading Paper

Paper Jams Inside the Product

If you see a message that paper has jammed in the product, follow the on-screen instructions to locate
and remove the jammed paper.

Take the following precautions when removing jammed paper from the product:

* Remove the jammed paper carefully. Using too much force may damage the product.

» Unless specifically instructed, avoid tilting the product, placing it on its side, or turning it upside down,
as ink may spill.

Warning: Never touch the buttons on the control panel while your hand is inside the product. If the
product starts operating, it may cause an injury. Do not touch any protruding parts inside the product.

Parent topic: Solving Paper Problems

Related topics
Loading Paper

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:

« If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.
Select the correct paper size when you reprint.

« If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select
the correct paper type setting when you reprint.

Parent topic: Solving Paper Problems

Related references
Paper or Media Type Settings - Printing Software

Related tasks
Cancelling Printing Using a Product Button

Related topics
Loading Paper
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Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Note: For problems while printing with the Epson Universal Print Driver or PostScript (PS3) printer
software, see the sections covering that software in this manual.

Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Printing is Slow

Parent topic: Solving Problems

Nothing Prints
If you have sent a print job and nothing prints, try these solutions:
» Make sure your product is turned on.
» Make sure any interface cables are connected securely at both ends.

+ If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,
connect your product directly to your computer instead of the hub.

* Make sure the printer status is not offline or pending.

* Run a product check to see if a test page prints. If the test page prints, check to see if your product
software is installed correctly.

* In Windows, make sure your product is selected as the default printer.
* In Windows, make sure the printer port setting matches the printer connection port.

* In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel any stalled print jobs.

* On a Mac, make sure the printer is added to the printer list.

* On a Mac, make sure the printer is not paused.

» Make sure your product is turned on and connected to your computer.

» Make sure the Printer Settings > Printing Language setting is set to Auto or PS3.
» Make sure your product is selected as the printer in your printing program.
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* In Windows, the product may not print if a large number of print jobs are sent. Try selecting Print
directly to the printer on the Advanced tab in the printer properties.

Parent topic: Solving Problems Printing from a Computer

Related tasks
Using AirPrint
Running a Product Check

Product Icon Does Not Appear in Windows Taskbar

If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:

1. Do one of the following:
* Windows 10: CIickn and select (Settings) > Devices > Printers & scanners. Select your
product name and select Manage > Printing preferences.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name, select Printing Preferences, and select
your product name again if necessary.

* Windows 7: Click E]' and select Devices and Printers. Right-click your product name, select
Printing Preferences, and select your product name again if necessary.

* Windows Vista: Click E]' select Control Panel, and click Printer under Hardware and Sound.
Right-click your product name, select Printing Preferences, and select your product name again if
necessary.

Click the Maintenance tab.

Click the Extended Settings button.

Select Enable EPSON Status Monitor 3 and click OK.

Click the Monitoring Preferences button.

Click the checkbox for the option that adds the shortcut icon to the taskbar.
Click OK to close the open program windows.

No o bk e

Parent topic: Solving Problems Printing from a Computer
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Printing is Slow
If printing becomes slow, try these solutions:

Make sure your system meets the requirements for your operating system. If you are printing a high-
resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

If you are using Windows 7, close the Devices and Printers window before you print.
Make sure Quiet Mode is turned off.

Clear space on your hard drive or run a defragmentation utility to free up existing space.
Close any programs you are not using when you print.

If your product is connected to a USB hub, connect it directly to your computer instead.

If printing becomes slower after printing continuously for a long time, the product may have
automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.

If you are using the Windows PostScript printer software, try selecting Fast as the Print Quality
setting on the Advanced tab of the printer software.

For the fastest printing, select the following settings in your product software:

Make sure the paper type setting matches the type of paper you loaded.

Turn on any high speed settings in your product software.

Select a lower print quality setting.

Make sure the ink drying time has not been increased for double-sided printing.

Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress,
and select the following settings:

+ Always Spool RAW Datatype
* Page Rendering Mode
* Print as Bitmap

Windows: Select Printing preferences, click the More Options tab and make sure the High Speed
setting is enabled.

Mac: Select System Preferences , select Printers & Scanners, then select your product. Select
Options & Supplies, then select Options (or Driver) and enable the High Speed Printing setting.
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If printing is still slow and you are using Windows 7 or Windows Vista, try the following:

1. Click E" and select Computer or My Computer. Double-click the C: drive and open these folders:
ProgramData > EPSON > PRINTER.

Note: If you do not see the ProgramData folder, open the Organize menu and select Folder and
search options. In the window that appears, click the View tab, select Show hidden files, folders,
and drives in the Advanced settings list, and click OK.

2. Right-click the EPAUDF01.AUD file and select Delete.
3. Restart your computer and try printing again.
Parent topic: Solving Problems Printing from a Computer

Related references

Paper or Media Type Settings - Printing Software
Windows System Requirements

Mac System Requirements

Related tasks

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac
Selecting Extended Settings - Windows

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Inverted Image

Too Many Copies Print

Blank Pages Print

Incorrect Margins on Printout
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout
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Parent topic: Solving Problems

Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
» Turn off any mirror or inversion settings in your printing application.

» Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer
software. (This option has different names, depending on your operating system version.)

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Basic Print Settings - Mac

Too Many Copies Print

Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac

Blank Pages Print
If blank pages print unexpectedly, try these solutions:
» Make sure you selected the correct paper size settings in your printing program and printer software.

 If a blank page exists in a document you are printing and you want to skip printing it, select the Skip
Blank Page setting in your printer software, if available.

* Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if
necessary.

» Make sure your product is selected as the printer in your printing program.
Parent topic: Solving Page Layout and Content Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning
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Related tasks

Selecting Extended Settings - Windows
Selecting Printing Preferences - Mac
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
* Make sure you selected the correct paper size settings in your printing program and printer software.
* Make sure you selected the correct margins for your paper size in your printing program.
» Make sure your paper is positioned correctly for feeding into the product.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac

Related topics
Loading Paper

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
* Make sure any cables are securely connected at both ends.
* In Windows, delete all print jobs from the Windows Spooler:
* Windows 10: Click E and select &4 (Settings) > Devices > Printers & scanners. Select your

product name and select Manage > Open print queue. Right-click the stalled print job, click
Cancel, and click Yes.

+ Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name, select See what's printing, and select your
product name again, if necessary. Right-click the stalled print job, click Cancel, and click Yes.

* Windows 7: Click E’ and select Devices and Printers. Right-click your product name, select See
what's printing, and select your product name again, if necessary. Right-click the stalled print job,
click Cancel, and click Yes.
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* Windows Vista: Click EI' and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, and select Open. Right click the stalled print job, click Cancel, and
click Yes.

In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Maintenance tab in
the printer settings window, and cancel any stalled print jobs.

If your product is connected to a USB hub, connect it directly to your computer instead.

If your computer entered sleep mode the last time you printed, the next print job after your computer
exits sleep mode may contain garbled characters. Print your document again.

If incorrect characters still appear in your prints, try connecting your product using a different cable.

Windows or Mac: Make sure you are using the printer software for this product. Check the product
name at the top of the driver window.

If you are using the PostScript printer software, EPS files created in binary format may not print
correctly. Try creating the file in ASCII format instead.

If you are using the Windows PostScript printer software, the product cannot print binary data if it is
connected to the computer using a USB cable. Try selecting ASCII or TBCP as the Output Protocol
setting on the Device Settings tab in the printer properties.

If you are using the Windows PostScript printer software, select the appropriate substitution fonts on
the Device Settings tab in the printer properties.

Parent topic: Solving Page Layout and Content Problems

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:

Make sure you selected the correct paper size and layout settings in your printing program and printer
software.

Make sure you selected the correct paper size on the control panel.
Make sure your paper is positioned correctly for feeding into the printer.
Slide the edge guides against the edges of the paper.

You can use the preview option in your printer software to check your margins before you print.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Additional Layout and Print Options - Windows
Cleaning Your Product
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Selecting Page Setup Settings - Mac
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac

Slanted Printout
If your printouts are slanted, try these solutions:
» Slide the edge guides against the edges of the paper.
+ Select a higher print quality setting in your printer software.
» Turn off any high speed settings in your product software.
* Align the print head.
» Adjust the print quality.
» Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac

Related topics
Loading Paper

Solving Print Quality Problems

Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

White or Dark Lines in Printout
Blurry or Smeared Printout

Faint Printout or Printout Has Gaps
Grainy Printout

Parent topic: Solving Problems
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White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

» Make sure the paper type setting matches the type of paper you loaded.

» Make sure you loaded the printable side of the paper correctly for your product.
» Turn off any high speed settings in your product software.

» Align the print head.

» Adjust the print quality in the product software.

* You may need to replace the ink pack.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Cleaning
Print Head Nozzle Check
Print Quality Adjustment

Related references
Paper or Media Type Settings - Printing Software

Related tasks
Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - Mac

Related topics
Replacing Ink Supply Units (Ink Packs) and Maintenance Boxes
Loading Paper

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:
» Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
» Slide the edge guides to the edges of the paper.
» Use a support sheet with special paper, or load special paper one sheet at a time.
» Make sure your paper meets the specifications for your product.
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Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
Make sure the paper type setting in your product software matches the type of paper you loaded.
Make sure you loaded the printable side of the paper correctly for your product.

If you are printing on thick paper or envelopes, turn on the Thick Paper setting from the control panel
or select Thick Paper and Envelopes in the Extended Settings of the printer software. (Turning this
setting on will decrease print speed.)

If you are printing on thick paper, select a thick paper Paper Type setting on the control panel.
Remove each sheet from the output tray as it is printed.
Turn off any high speed settings in your product software.

If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily
saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
Make sure the ink has dried before reloading the paper to print on the other side. Adjust the density
and/or ink drying time settings.

Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

Align the print head.
Adjust the print quality in the product software.
Clean the paper path.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that

extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Cleaning
Print Quality Adjustment

Related references
Available Epson Papers

Paper Specifications

Related tasks
Selecting Basic Print Settings - Windows
Selecting Additional Layout and Print Options - Windows
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Selecting Double-sided Printing Settings - Windows

Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

* The ink pack may be old or low on ink, and you may need to replace it.

* Make sure the paper type setting matches the type of paper you loaded.

» Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
* Align the print head.

+ Adjust the print quality in the product software.

* Clean the paper path.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Cleaning
Print Head Nozzle Check
Print Quality Adjustment

Related references
Paper or Media Type Settings - Printing Software

Related tasks

Cleaning the Paper Guide

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac

Related topics
Replacing Ink Supply Units (Ink Packs) and Maintenance Boxes
Loading Paper

Grainy Printout
If your printouts are grainy, try these solutions:
» Make sure you loaded the printable side of the paper correctly for your product.
» Select a higher print quality setting and turn off any high speed settings in your product software.
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Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

Align the print head.
Adjust the print quality.

You may need to increase the image resolution or print a smaller size; see your software
documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.

If you enlarged the image size in an image-editing program, you need to increase the image resolution
setting to retain a high image quality. Increase the image resolution by the same amount you increase
the image size. For example, if the image resolution is 300 dpi (dots per inch) and you will double the
image size for printing, change the resolution setting to 600 dpi.

Note: Higher resolution settings result in larger file sizes, which take longer to process and print.
Consider the limitations of your computer system when selecting a resolution, and select the lowest
possible resolution that produces acceptable quality to keep file sizes manageable.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Cleaning

Print Head Nozzle Check

Print Quality Adjustment
Print Head Alignment

Related tasks

Selecting Additional Layout and Print Options - Windows
Selecting Printing Preferences - Mac

Selecting Basic Print Settings - Windows

Selecting Basic Print Settings - Mac

Related topics
Loading Paper
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Uninstall Your Product Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.

Uninstalling Printing Software - Standard Epson Printer Software - Windows
Uninstalling Product Software - Mac

Parent topic: Solving Problems

Uninstalling Printing Software - Standard Epson Printer Software - Windows
You can uninstall and then re-install your printer software to solve certain problems.
1. Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:

* Windows 10: Click E and select k¥4 (Settings) > Apps > Apps & features. Select the program
you want to uninstall and select Uninstall.

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product, if necessary, and click OK. Then follow any on-screen
instructions.

* Windows (other versions): Click © or Start, and select All Programs or Programs. Select
Epson, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product, if necessary, and click OK. Then follow any on-screen
instructions.

4. Restart your computer, then re-install your software.
Note: If you find that re-installing your product software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Product Software
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Uninstalling Product Software - Mac

In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit epson.com/support (U.S.), epson.ca/support (Canada), or
epson.com.jm/support (Caribbean) and select your product.

Click Downloads.

Select your operating system, click Utilities, locate the Uninstaller utility, and click Download.
Run the file you downloaded.

Double-click the Uninstaller icon.

o g bk wbd

In the Epson Uninstaller screen, select the checkbox for each software program you want to
uninstall.

Click Uninstall.
Follow the on-screen instructions to uninstall the software.
9. Reinstall your product software.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan,
or Printers & Scanners window, select your product name and click the — (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help

If you need to contact Epson for technical support services, use the following support options.

Internet Support

Visit Epson's support website at epson.com/support (U.S.), epson.ca/support (Canada), or
epson.com.jm/support (Caribbean) and select your product for solutions to common problems. You can
download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your
questions.
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Speak to a Support Representative

Before you call Epson for support, please have the following information ready:
* Product name

* Product serial number (located on a label on the product)

» Proof of purchase (such as a store receipt) and date of purchase

» Computer configuration

» Description of the problem

Then call:

* U.S.:(5662) 276-7202, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific
Time, Saturday

+ Canada: (905) 709-2567, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM,
Pacific Time, Saturday

Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.
Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper at epson.com (U.S. sales), epson.ca (Canadian sales),
or epson.com.jm (Caribbean sales). You can also purchase supplies from an Epson authorized reseller.
To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.

Parent topic: Solving Problems
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Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this
site (Canada) for information on how to return your Epson products for proper disposal.

Windows System Requirements
Mac System Requirements
Paper Specifications

Printable Area Specifications
Ink Pack Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications

Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating
systems:

* Windows 10

* Windows 8.x

* Windows 7

* Windows Vista

* Windows Server 2016

* Windows Server 2012 R2
* Windows Server 2012

* Windows Server 2008 R2
* Windows Server 2008

* Windows Server 2003 R2
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Windows Server 2003 SP2 or later

Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean), select
your product, and select Downloads.

Parent topic: Technical Specifications

Mac System Requirements
To use your product and its software, your Mac should use one of these operating systems:

macOS 10.13.x
macOS 10.12.x
0OS X10.11.x
0S X 10.10.x
OS X 10.9.x
OS X 10.8.x
0OS X 10.7.x
0S X10.6.8

Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.), epson.ca/support (Canada), or epson.com.jm/support (Caribbean), select
your product, and select Downloads.

Parent topic: Technical Specifications

Paper Specifications

Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.
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Single-sheets

Size A4 (8.3 x 11.7 inches [210 x 297 mm])

A6 (4.1 x 5.8 inches [105 x 148 mm)])

Letter (8.5 x 11 inches [216 x 279 mm])

Legal (8.5 x 14 inches [216 x 356 mm])

Folio (8.5 x 13 inches [216 x 330 mm])

Executive (7.25 x 10.5 inches [184 x 267 mm])

Mexico-Oficio (8.5 x 13.4 inches [216 x 340 mm])

Oficio 9 (8.46 x 12.4 inches [215 x 315 mm])

4 x 6 inches (102 x 152 mm)

5 x 7 inches (127 x 178 mm)

8 x 10 inches (203 x 254 mm)

3.5 x 5inches (89 x 127 mm)

Half Letter (5.5 x 8.5 inches [140 x 216 mm])
Paper types Plain paper and paper distributed by Epson
Weight Plain paper: 17 Ib (64 g/m?) to 24 Ib (90 g/m?)

Thick paper: 25 Ib (91 g/m?) to 68 Ib (256 g/m?)

Envelopes

Size No. 10 (4.1 x 9.5 inches [105 x 241 mm])
Paper types Plain bond paper

Weight 20 Ib (95 g/m?) to 24 Ib (90 g/m?)

Parent topic: Technical Specifications

Related references
Paper Loading Capacity
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Printable Area Specifications

Single sheets

2| | —
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1 Top/bottom/right/left: 0.12 inch (3 mm) minimum

2 Reduced print quality area/top: 1.85 inches (47 mm) minimum

3  Reduced print quality area/bottom: 1.77 inches (45 mm) minimum

Envelopes

—x

T

"

v

I_

I_

'f///
|

H

213



Left/right: 0.12 inch (3 mm) minimum
Top/bottom: 0.20 inch (5 mm) minimum
Reduced print quality area/left: 0.71 inch (18 mm) minimum

A WODN -~

Reduced print quality area/right: 1.85 inches (47 mm) minimum
Parent topic: Technical Specifications
Ink Pack Specifications

Note: This printer is designed for use with Epson ink packs only, not third-party ink packs or ink. Other
brands of ink supplies are not compatible and, if described as compatible, may not function properly or
continuously. Such restrictions can be avoided with some other printers such as Epson EcoTank
cartridge-free printers.

The included initial ink pack is designed for reliable printer setup and cannot be used as a replacement
ink pack or resold. After setup, the remaining ink is available for printing. Yields are based on ISO 24711
in default mode, printing continuously. Yields vary due to print images, settings, and temperatures.
Printing infrequently reduces yields. Your ink pack must be installed with ink for printing and printer
maintenance. For print quality, some ink remains in the replaced ink pack.

Color Black

Ink pack life Opened package: 2 years
Unopened package: do not use if the date on the package has
expired

Temperature Storage: —22 to 104 °F (=30 to 40 °C)

1 month at 104 °F (40 °C)
Ink freezes at 8.6 °F (—13 °C)
Ink thaws and is usable after 5 hours at 77 °F (25 °C)

Parent topic: Technical Specifications

Related references
Ink Supply Unit (Ink Pack) Part Numbers
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Dimension Specifications
Printer only

Height
Width
Depth

Weight
(without ink pack or power cord)

Printer with 1 optional cassette

Height
Width
Depth

Weight
(without ink pack or power cord)

357 mm)
449 mm)
425 mm)
425 mm)

Storage: 14.1 inches
Printing: 17.7 inches

o~

—

Storage: 16.7 inches
Printing: 16.7 inches
Storage: 21.1 inches (535 mm); with output tray installed
Printing: 22.8 inches (578 mm)

Approx. 32.8 Ib (14.9 kg)

A~ o~~~

Storage: 18.0 inches (457 mm)

Printing: 21.6 inches (549 mm)

Storage: 16.7 inches (425 mm)

Printing: 16.7 inches (425 mm)

Storage: 21.1 inches (535 mm); with output tray installed
Printing: 22.8 inches (578 mm)

Approx. 43.0 Ib (19.5 kg)

Parent topic: Technical Specifications

Electrical Specifications

Power supply rating
Rated frequency range
Rated current

100to 240V
50 to 60 Hz
09t00.5A
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Power consumption Printing: Approximately 23 W (ISO/IEC24712)
Ready mode: Approximately 10 W
Sleep mode: Approximately 1.4 W
Power off mode: Approximately 0.2 W

Parent topic: Technical Specifications

Environmental Specifications

Temperature Operating: 50 to 95 °F (10 to 35 °C)
Storage: —4 to 104 °F (—20 to 40 °C)
1 month at 104 °F (40 °C)

Humidity Operating: 20 to 80% RH

(without condensation) Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications
Interface type Hi-Speed USB (Device Class for computers)
Parent topic: Technical Specifications

Network Interface Specifications
Wi-Fi

Standard IEEE 802.11 b/g/n; complies with either IEEE 802.11 b/g or IEEE
802.11 b/g/n, depending on purchase location
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Security

Frequency band

Maximum radio-frequency
power transmitted

Communication mode

Ethernet

Standard

Communication mode

Connector

WPA2-PSK (AES); complies with WPA2 standards with support for
WPA/WPA2 Personal

WPAZ2-Enterprise (AES)
WEP (64/128 bit)

Note: Wi-Fi Direct mode supports only WPA2-PSK (AES) security.
2.4 GHz
20 dBm (EIRP)

Infrastructure mode
Wi-Fi Direct (Simple AP); not supported for IEEE 802.11b

Note: Wi-Fi Direct Simple AP mode available even if you connect
the product to an Ethernet network.

IEEE802.3i (10BASE-T)*
IEEE802.3u (100BASE-TX)
IEEE802.3ab (1000BASE-T)*

IEEE802.3az (Energy Efficient Ethernet); the connected device
should be IEEE802.3az compliant

Auto, 10Mbps Full duplex, 10Mbps Half duplex, 100Mbps Full
duplex, 100Mbps Half duplex

RJ-45

* Use a category 5e or higher STP (Shielded twisted pair) cable to prevent risk of radio interference.

Security Protocol

IEEE802.1X; requires the connected device to comply with IEEE802.1X

IPsec/IP Filtering

SSL/TLS; either HTTPS Server/Client or IPPS

SMTPS (STARTTLS, SSL/TLS)
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SNMPv3
Parent topic: Technical Specifications

Safety and Approvals Specifications

United States Safety: UL60950-1
EMC: FCC part 15 Subpart B class B
Canada Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module:
» Manufacturer: Seiko Epson Corporation
* Type: J26H006

This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment
and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102
of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities:
hands, wrists, feet and ankles).

Parent topic: Technical Specifications
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Notices

Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this
site (Canada) for information on how to return your Epson products for proper disposal.

Important Safety Instructions

FCC Compliance Statement

Binding Arbitration and Class Waiver
Trademarks

Copyright Notice

Important Safety Instructions
Before using your Epson product, read and follow these safety instructions.

General Printer Safety Instructions

Ink Pack Safety Instructions

Wireless Connection Safety Instructions
LCD Screen Safety Instructions

Parent topic: Notices

General Printer Safety Instructions
» Be sure to follow all warnings and instructions marked on the printer.

» Use only the power cord that comes with the printer. Use of another cord may cause fires or shock. Do
not use the cord with any other equipment.

» Make sure the AC power cord meets the relevant local safety standard.
* Place the printer near a wall outlet where the plug can be easily unplugged.

* Avoid plugging the printer into an outlet on the same circuit as a photo copier or air control system that
regularly switches on and off, or on an outlet controlled by a wall switch or timer.

* Do not let the power cord become damaged or frayed.

* If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged
into the extension cord does not exceed the cord’'s ampere rating. Also, make sure the total ampere
rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.
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Always turn off the printer using the power button, and wait until the power light stops flashing before
unplugging the printer or cutting off power to the electrical outlet.

Place the printer on a flat, stable surface that extends beyond its base in all directions. It will not
operate properly if it is tilted or at an angle.

Keep your product at least 8.7 inches (22 cm) away from cardiac pacemakers to prevent your
product's radio waves from affecting the operation of the pacemaker.

Leave enough space in front of the printer for the paper to be fully ejected.
Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
Do not place the printer near a radiator or heating vent or in direct sunlight.

Leave enough room around the printer for sufficient ventilation. Do not block or cover openings in the
case or insert objects through the slots.

Keep the printer away from potential sources of electromagnetic interference, such as loudspeakers or
the base units of cordless telephones.

Do not touch the flat white cable inside the printer.
Do not move the print head by hand; this may damage the printer.
Do not spill liquid on the printer and do not handle the printer with wet hands.

Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may
cause fire.

Except as specifically explained in your documentation, do not attempt to service the printer yourself.

Unplug the printer and refer servicing to qualified service personnel under the following conditions: if
the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped
or the case damaged; if the product does not operate normally or exhibits a distinct change in
performance. Adjust only those controls that are covered by the operating instructions.

If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are fuses in
the plug, make sure you replace them with fuses of the correct size and rating.

Unplug the power cord from the electrical outlet if you are not going to use the printer for an extended
period.

Before transporting the printer, make sure that the print head is in the home (far right) position and the
ink pack is installed.

When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside down;
otherwise ink may leak.

Parent topic: Important Safety Instructions
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Ink Pack Safety Instructions
» Keep ink packs and maintenance boxes out of the reach of children and do not drink the ink.

» Be careful when you handle used ink packs; there may be ink remaining around the ink supply port. If
ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately
with water. If discomfort or vision problems continue after a thorough flushing, see a doctor
immediately. If ink gets in your mouth, see a doctor right away.

* Do not put your hand inside the product or touch the ink pack during printing.

* Install a new ink pack immediately after removing the expended one. Leaving the ink pack uninstalled
can dry out the print head and may prevent the product from printing.

* Do not remove or tear the label on the ink pack; this can cause leakage.

* Do not remove the transparent seal from the ink supply area. This may cause the ink pack to become
unusable.

» Do not touch the green IC chip on the side of the handle. This may prevent normal operation.

* Do not shake ink packs too vigorously; otherwise ink may leak.

+ Use an ink pack before the date printed on its package.

» Do not disassemble an ink pack or a maintenance box. Ink may get in your eyes or on your sKkin.
» Store ink packs in a cool, dark place.

+ After bringing an ink pack inside from a cold storage site, allow it to warm up at room temperature for
at least 12 hours before using it.

» Store ink packs with the bottom facing down.
Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions

Radio waves from this product may adversely affect the operation of medical equipment or automatically
controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near
such devices or inside a medical facility, follow the directions from authorized staff members at the
facility, and follow all posted warnings and directions on the device to avoid causing an accident.

Parent topic: Important Safety Instructions

LCD Screen Safety Instructions
» Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.
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+ If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash
them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor
immediately.

* Do not press too hard on the LCD screen or subject it to heavy impacts.
» Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.

+ Ifthe LCD screen chips or cracks, do not touch or attempt to remove the broken pieces; contact Epson
for support.

* Do not subject your product to sudden changes in temperature or humidity; this may cause
condensation to develop inside the LCD screen and degrade its performance.

Parent topic: Important Safety Instructions

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

+ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.
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For Canadian Users
CAN ICES-3(B)/NMB-3(B)
Parent topic: Notices

Binding Arbitration and Class Waiver

1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND
CLASS ARBITRATIONS

1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term
"Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim,
controversy or action between you and Epson arising out of or relating to this Agreement, Epson
branded products (hardware and including any related software), or other transaction involving you and
Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation,
ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more
specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement,
(c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson
also agree, notwithstanding Section 1.6,that a court, not an arbitrator, may decide if a claim or cause of
action is for an IP Claim.

1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration
according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE
OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED.
Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized
arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but
excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see
Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C.
§1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement
memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this
Agreement.

1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to
try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to
resolve the Dispute within the sixty (60) days), you or Epson may commence an arbitration. Notice to
Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3840 Kilroy Airport Way,
Long Beach, CA 90806 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent
address Epson has in its records for you. For this reason, it is important to notify us if your address
changes by emailing us at EAlLegal@ea.epson.com or writing us at the Epson Address above. Notice of
the Dispute shall include the sender's name, address and contact information, the facts giving rise to the
Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson
and you agree to act in good faith to resolve the Dispute before commencing arbitration.
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1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small
claims court of your state or municipality if the action is within that court's jurisdiction and is pending only
in that court.

1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT
EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL
CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR
REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE
CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE
ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING
WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED.
ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN
ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS
WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION
PROCEEDING.

1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by
the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration
on a class or representative basis (the "JAMS Rules"), available at http://www.jamsadr.com or by calling
1-800-352-5267, and under the rules set forth in this Agreement. All Disputes shall be resolved by a
single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the
selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not
any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising
out of or relating to the interpretation, applicability, enforceability or formation of this Agreement,
including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad
delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or
cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1
above. The arbitrator shall be empowered to grant whatever relief would be available in a court under
law or in equity. The arbitrator may award you the same damages as a court could, and may award
declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent
necessary to provide relief warranted by that party's individual claim. In some instances, the costs of
arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration
than in court. The arbitrator's award is binding and may be entered as a judgment in any court of
competent jurisdiction.

You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by
telephone shall take place in a location reasonably accessible from your primary residence, or in Orange
County, California, at your option.

a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties
agree to the following procedure:
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(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount
of damages sought to be recovered. You can find a copy of a Demand for Arbitration at
http://www.jamsadr.com ("Demand for Arbitration").

(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North
State College Blvd., Suite 600 Orange, CA 92868, U.S.A.

(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute
Notice), or as otherwise agreed by the parties.

b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed
to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled.
The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during
the arbitration.

c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator
fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.

d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive
of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater
than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount
of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if
any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney
reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as
agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and
expenses to be paid by Epson pursuant to this Section 1.6d).

e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced
involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section
1.6d) above does not limit your rights to attorney's fees and expenses under applicable law;
notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and
expenses.

1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual
arbitration procedure and waiver of class and representative proceedings specified in this
Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent
to this Agreement (including without limitation the purchase, download, installation of the
Software or other applicable use of Epson Hardware, products and services) that specifies (i)
your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding
individual arbitration procedure and waiver of class and representative proceedings specified in
this Section 1. In the event that you opt-out consistent with the procedure set forth above, all
other terms shall continue to apply, including the requirement to provide notice prior to litigation.

1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you
and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and
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class action waiver provisions (other than a change to Epson's address) in this Agreement, Epson will
obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the
applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in
accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you
timely elected to opt-out when you first assented to this Agreement).

1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be
severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not
apply to the prohibition against class or representative actions as provided in Section 1.5. This
means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1)
shall be null and void.

Parent topic: Notices

Trademarks

EPSONP® s a registered trademark, EPSON Exceed Your Vision is a registered logomark, and Epson
Connect™ is a trademark of Seiko Epson Corporation.

Epson iPrint™ and Remote Print™ are trademarks of Seiko Epson Corporation.

Apple, App Store, AirPrint, AirPrint logo, iPad, iPhone, iPod touch, Mac, macOS, and OS X are
trademarks of Apple Inc., registered in the U.S. and other countries.

Google® is a registered trademark and Android™, Chromebook™, Gmail™, Google Chrome™, Google
Cloud Print™, Google Drive™, and Google Play™ are trademarks of Google LLC.

Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.

General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

EPSON

EXCEED YOUR VISION

Parent topic: Notices

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
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designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution

Parent topic: Notices

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets
Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.

Parent topic: Copyright Notice

Copyright Attribution
© 2018 Epson America, Inc.

227



7/18
CPD-55474R2
Parent topic: Copyright Notice

228



	Contents
	Product Basics
	Using the Control Panel
	Control Panel Buttons and Lights
	Status Icon Information

	Changing LCD Screen Language
	Selecting the Date and Time
	Adjusting the Screen Brightness
	Setting a Password and Locking the Control Panel
	Entering Characters on the LCD Screen

	Turning Off the Operation Time Out Setting
	Preventing PC Connection via USB

	Product Parts Locations
	Product Parts - Front
	Product Parts - Inside
	Product Parts - Back

	The Power Off and Sleep Timers
	Changing the Sleep Timer Settings
	Changing the Power Off Timer Settings

	Epson Connect Solutions for Smartphones, Tablets, and More
	Setting Up Epson Connect Services
	Using Epson Email Print
	Using the Epson iPrint Mobile App
	Using Epson Remote Print

	Using AirPrint
	Using Google Cloud Print
	Setting Up Google Cloud Print on a Chromebook

	Using the Mopria Print Service
	Android Printing Using the Epson Print Enabler
	Using Fire OS Printing
	Using Windows 10 Mobile Printing
	Printing with NFC from Your Android Device

	Wi-Fi or Wired Networking
	Network Security Recommendations
	Wi-Fi Infrastructure Mode Setup
	Selecting Wireless Network Settings from the Control Panel

	Wi-Fi Direct Mode Setup
	Enabling Wi-Fi Direct Mode

	Wi-Fi Protected Setup (WPS)
	Using WPS to Connect to a Network

	Printing a Network Status Sheet
	Changing or Updating Network Connections
	Accessing the Web Config Utility
	Changing a USB Connection to a Wi-Fi Connection
	Changing a Wi-Fi Connection to a Wired Network Connection
	Connecting to a New Wi-Fi Router
	Disabling Wi-Fi Features


	Enabling Epson Universal Print Driver (PCL) or PostScript Printing
	Installing the Epson Universal Print Driver - Windows
	Installing the PostScript (PS3) Printer Software - Windows
	Installing the PostScript (PS3) Printer Software - Mac
	Selecting PDL (Page Description Language) Settings
	PDL Print Configuration Options

	Selecting Printer Language and Interface Settings
	Printing Language and Interface Options

	Printing a PCL or PS3 (PostScript) Font List

	Loading Paper
	Installing the Optional Paper Cassette Unit
	Enabling the Optional Paper Cassette - Windows
	Enabling the Optional Paper Cassette - Mac

	Loading Paper in the Cassette
	Loading Paper or Envelopes in the Rear Paper Feed Slot
	Paper Loading Capacity
	Double-sided Printing Capacity
	Available Epson Papers
	Paper or Media Type Settings - Printing Software
	Selecting the Paper Settings for Each Source - Control Panel
	Paper Type Settings - Control Panel

	Selecting Default Paper Settings - Administrator
	Selecting the Default Printer Settings
	Paper Source Settings Options

	Selecting the Universal Print Settings
	Universal Print Settings Options



	Printing from a Computer
	Printing with the Standard Epson Printer Software - Windows
	Selecting Basic Print Settings - Windows
	Paper Source Options - Windows
	Print Quality Options - Windows
	Multi-Page Printing Options - Windows

	Selecting Double-sided Printing Settings - Windows
	Double-sided Printing Options - Windows
	Print Density Adjustments - Windows

	Selecting Additional Layout and Print Options - Windows
	Image Options and Additional Settings - Windows
	Header/Footer Settings - Windows

	Selecting a Printing Preset - Windows
	Selecting Extended Settings - Windows
	Extended Settings - Windows

	Printing Your Document or Photo - Windows
	Locking Printer Settings - Windows
	Locked Setting Options

	Selecting Default Print Settings - Windows
	Changing the Language of the Printer Software Screens

	Changing Automatic Update Options

	Printing with the Built-in Epson Driver - Windows 10 S
	Selecting Print Settings - Windows 10 S

	Printing with the Epson Standard Printer Software - Mac
	Selecting Basic Print Settings - Mac
	Paper Source Options - Mac
	Print Quality Options - Mac

	Selecting Page Setup Settings - Mac
	Selecting Print Layout Options - Mac
	Selecting Double-sided Printing Settings - Mac
	Double-sided Printing Options and Adjustments - Mac

	Managing Color - Mac
	Color Matching - Mac

	Selecting Printing Preferences - Mac
	Printing Preferences - Mac

	Printing Your Document or Photo - Mac
	Checking Print Status - Mac


	Printing with the Epson Universal Print Driver - Windows
	Synchronizing Printer Settings - Epson Universal Print Driver - Windows
	Selecting Print Settings - Epson Universal Print Driver - Windows
	Selecting Default Print Settings - Epson Universal Print Driver - Windows
	Locking Printer Settings - Epson Universal Print Driver - Windows
	Epson Universal Print Driver Locked Setting Options

	Adding Network Printers - Epson Universal Print Driver - Windows

	Printing with the PostScript (PS3) Printer Software - Windows
	Enabling the Optional Paper Cassettes - PostScript Printer Software - Windows
	Selecting Print Settings - PostScript Printer Software - Windows
	Selecting Default Print Settings - PostScript Printer Software - Windows
	Accessing Printer Properties - PostScript - Windows

	Printing with the PostScript (PS3) Printer Software - Mac
	Enabling the Optional Paper Cassettes - PostScript Printer Software - Mac
	Selecting Print Settings - PostScript Printer Software - Mac

	Cancelling Printing Using a Product Button

	Replacing Ink Supply Units (Ink Packs) and Maintenance Boxes
	Check Ink and Maintenance Box Status
	Checking Ink Status on the LCD Screen
	Checking Ink and Maintenance Box Status - Windows
	Checking Ink and Maintenance Box Status - Mac

	Purchase Epson Ink Packs and Maintenance Boxes
	Ink Supply Unit (Ink Pack) Part Numbers

	Removing and Installing Ink Packs
	Maintenance Box Replacement

	Adjusting Print Quality
	Print Head Maintenance
	Print Head Nozzle Check
	Checking the Nozzles Using the Product Control Panel
	Checking the Nozzles Using a Computer Utility

	Print Head Cleaning
	Cleaning the Print Head Using the Product Control Panel
	Cleaning the Print Head Using a Computer Utility
	Enabling the Periodic Cleaning Setting


	Print Quality Adjustment
	Adjusting the Print Quality Using the Product Control Panel

	Print Head Alignment
	Aligning the Print Head Using the Product Control Panel

	Cleaning the Paper Guide

	Cleaning and Transporting Your Product
	Cleaning Your Product
	Transporting Your Product

	Solving Problems
	Checking for Software Updates
	Product Status Messages
	Running a Product Check
	Resetting Control Panel Defaults
	Solving Setup Problems
	Product Does Not Turn On or Off
	Noise After Ink Installation
	Software Installation Problems

	Solving Network Problems
	Product Cannot Connect to a Wireless Router or Access Point
	Network Software Cannot Find Product on a Network
	Product Does Not Appear in Mac Printer Window
	Cannot Print Over a Network

	Solving Paper Problems
	Paper Feeding Problems
	Paper Jams Inside the Product
	Paper Ejection Problems

	Solving Problems Printing from a Computer
	Nothing Prints
	Product Icon Does Not Appear in Windows Taskbar
	Printing is Slow

	Solving Page Layout and Content Problems
	Inverted Image
	Too Many Copies Print
	Blank Pages Print
	Incorrect Margins on Printout
	Incorrect Characters Print
	Incorrect Image Size or Position
	Slanted Printout

	Solving Print Quality Problems
	White or Dark Lines in Printout
	Blurry or Smeared Printout
	Faint Printout or Printout Has Gaps
	Grainy Printout

	Uninstall Your Product Software
	Uninstalling Printing Software - Standard Epson Printer Software - Windows
	Uninstalling Product Software - Mac

	Where to Get Help

	Technical Specifications
	Windows System Requirements
	Mac System Requirements
	Paper Specifications
	Printable Area Specifications
	Ink Pack Specifications
	Dimension Specifications
	Electrical Specifications
	Environmental Specifications
	Interface Specifications
	Network Interface Specifications
	Safety and Approvals Specifications

	Notices
	Important Safety Instructions
	General Printer Safety Instructions
	Ink Pack Safety Instructions
	Wireless Connection Safety Instructions
	LCD Screen Safety Instructions

	FCC Compliance Statement
	Binding Arbitration and Class Waiver
	Trademarks
	Copyright Notice
	A Note Concerning Responsible Use of Copyrighted Materials
	Default Delay Times for Power Management for Epson Products
	Copyright Attribution



